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ABSTRACT 

 

 

 

LINKING RIPARIAN VEGETATION TO PRECIPITATION USING NDVI AT  

YUMA PROVING GROUND, ARIZONA 

 
 

 

Measuring precipitation in semi-arid landscapes is important for understanding the processes 

related to rainfall and run-off.  However, rain gauges are sparsely distributed.  Linear regressions 

comparing rain gauge and RADAR precipitation estimates revealed that RADAR data is often misleading 

especially for monsoon type storms.  This study investigates an alternative way to map the spatial and 

temporal variation of precipitation inputs along ephemeral stream channels using NDVI derived from 

Landsat TM imagery.  NDVI was derived on 26 pre- and post-monsoon season Landsat images across 

Yuma Proving Ground (YPG) in southwestern Arizona.  The mean NDVI values along ephemeral stream 

channels explained 73% of the variance in precipitation totals from a nearby rain gauge for 25 monsoon 

seasons.  A 0.0006 increase in NDVI per day between pre- and post-monsoon season imagery was found 

to indicate high precipitation inputs and possibly indicate flow events. 

A second set of Landsat TM imagery were used to relate gains in NDVI during seven winter seasons 

to precipitation recorded from a nearby NEXRAD radar station.  The NEXRAD Stage IV radar data were 

found to be more accurate during winter precipitation events when associated with rain gauge stations 

(adjusted R2: 0.81 & 0.84).  High correlations were found between NDVI and precipitation at the 32, 48, 

64 and 96d time intervals, though each season varied.  The number of precipitation events with >5mm 

at the 96d interval showed significant correlation (0.63 & 0.77) while the number of events with >10mm 

had less correlation.  Moreover, the combination and analysis of these two NDVI datasets revealed that 

wet winters may influence the vegetation for more than four years into the future.  
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CHAPTER 1: INTRODUCTION 

 

 

 

The goal of this research is to investigate the influences of precipitation on vegetation and to use 

vegetation to detect precipitation inputs along ephemeral stream channels.  This was done by using 

vegetation indices from Landsat TM time series on a semi-arid ecosystem that experiences two rainy 

seasons: summer monsoon and winter frontal storms.  The first objective of this research was to 

measure the change in NDVI values between pre- and post-monsoon season Landsat 5 & 7 TM imagery 

for 26 years.  These data have recorded the intensity and spatial distribution of plant growth (i.e. an 

increase in chlorophyllic content; Pettorelli et al., 2005) from monsoon season rain events at YPG and 

the distribution and length of droughts (i.e. little to no increase in chlorophyllic content).  The second 

objective was to relate the response in vegetation to winter precipitation events using NEXRAD radar 

data and NDVI derived from Landsat 5 TM imagery.  For this objective, I hypothesize that: 1) winter 

precipitation is highly correlated to increases in NDVI along ephemeral stream channels at YPG and 2) 

there is an associated lag time between the precipitation event and the NDVI response along ephemeral 

stream channels and this lag-time varies depending upon the amount and timing of precipitation.  

Furthermore, the agglomeration of both datasets may indicate climatic or environmental trends and 

possibly better explain the vegetation along the ephemeral stream channels at YPG and the effects of 

antecedent precipitation events.   

This manuscript also includes Appendices A-E which supports the main objectives of this study.  

Appendix A documents the data used.  Appendix B expands upon the methods that are described in the 

main document.  Appendix C is devoted entirely to the statistical analysis used in comparing rain gauge 

and the NEXRAD and PRISM datasets.  The results shown in Appendix C guided this research by 

evaluating the precipitation data among the monsoon and winter seasons.  Appendix D illustrates the 

NEXRAD radar daily precipitation totals, the PRISM temperature means, and the change in NDVI using 
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the MTT values for each of the seven winter seasons.  Appendix E documents the change in NDVI/day 

across the Riparian Area Polygons for each of the 26 monsoon seasons.  Appendix F is independent from 

the main document and Appendices A-E.  Appendix F contains a GIS tutorial created in coordination with 

the Strategic Environmental Research and Development Program (SERDP) RS-1727 grant funded project 

and explains the creation of various geomorphic parameters at three hierarchal scales (Reach, Valley, 

and Watershed).  These parameters were created at four DoD installations: Fort Irwin, Fort Bliss, Fort 

Huachuca, and Yuma Proving Ground. 
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CHAPTER 2: LITERATURE REVIEW 

 

 

 

Measuring precipitation in semi-arid regions is necessary for understanding the abiotic and biotic 

components within these landscapes.  Vegetation in semi-arid landscapes has been shown to be 

inextricably linked to precipitation events most of which tend to be local and infrequent (Huxman et al., 

2004).  The changing climate further warrants improving upon the ways in which we map and monitor 

vegetation and precipitation in semi-arid regions.  Measuring precipitation in these areas has many 

associated problems that cause spatial and temporal discontinuity in datasets.  Long-term rain gauge 

data exists, but are scarce, spatially disparate and hard to find (Goodrich et al., 2008).  Advances in radar 

technology have allowed for spatially continuous precipitation data, but they lack the historic record to 

observe long-term trends of multiple decades or more.  In addition, the accuracy is often contingent 

upon the storm type and topography making these data, at times, unreliable.  In water-limiting systems, 

where the relationship between precipitation influence and the vegetation response is robust, 

precipitation may indirectly be measured through satellite imagery to improve upon discontinuous 

datasets (Barbosa et al., 2006). 

Many factors influence vegetation in arid ecosystems such as geomorphology, soil, and land use 

history, but the primary determinant of plant productivity in arid landscapes is the availability and 

timing of water (Huxman et al., 2004; Brooks et al., 2011).  The vegetation within these environments 

often survives by small and infrequent rain events of 2mm or less (Collins et al., 2008).  Higher intensity 

precipitation events tend to create runoff and short-lived flow events during convective monsoon 

season storms, but are even more infrequent (Snyder & Tartowski, 2006; Shaw & Cooper, 2007; Lichvar 

et al., 2009; Svoray & Karnieli, 2011).  Much of the precipitation delivered from these rain events flows 

into the associated riparian areas, while, strong transmission losses within the ephemeral stream 
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channels often keep these runoff events local (Goodrich et al., 2008).  Furthermore, monsoon season 

precipitation can be highly variable for the Southwest region (National Weather Service, n.d.). 

In contrast, precipitation delivered from winter frontal storms tends to be more widespread and 

longer lasting than monsoon season events.  These storm types generally contribute to higher 

infiltration depths and have lower runoff potential consequently keeping much of the precipitation in 

the uplands instead of the ephemeral stream channels (Snyder & Tartowski, 2006, Goodrich, et al. 

2008).  Winters that experience significant precipitation and moderate temperatures (often linked with 

the El Niño Southern Oscillation (ENSO); Goodrich et al., 2008) can promote higher densities of 

herbaceous annuals (Bowers, 2005; Kimball et al., 2010).  For example, the 2004-05 winter in 

southwestern Arizona experienced above average precipitation and caused herbaceous annuals to 

proliferate.  The greater quantities of above ground biomass fueled a fire that swept through Yuma 

Proving Ground (YPG) and KOFA National Wildlife Refuge preserve in October of the following year 

(Esque et al., 2013).  This event demonstrates the importance of monitoring precipitation inputs and 

vegetation responses of both the summer monsoon and winter frontal seasons. 

Vegetation in arid climates responds to rainfall by producing biomass to such an extent that it can 

be detected by satellite imagery, however, not all rain events produce enough precipitation to be 

utilized by plants.  The fraction of rain that is available to plants varies depending on the type, quantity, 

and timing of precipitation since rain is lost to many other hydrologic processes (Brooks et al., 2011).  

Small rain events (<2mm) may only influence the microbial community which aids in the production of 

carbon and nitrogen that are necessary for other biological processes (Collins et. al., 2008).  Some plants 

will only respond to substantial rain events such as pulse events that may initiate growth, while other 

vegetation will respond better to rainfall divided amongst several rain events (Ogle & Reynolds, 2004).  

However, larger plants and higher vegetation densities that exist within the ephemeral stream network 
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are dependent on the high runoff from infrequent monsoon season storms that funnel water into these 

channels (Shaw & Cooper, 2008).  A study in the Chihuahuan Desert found that one large rain event of 

20mm per month produced more aboveground net primary productivity on a C4 grass than did four 

5mm rain events distributed over a month during the 2007 and 2008 monsoon seasons (Thomey et al., 

2011).  Moreover, a large rain event may produce more runoff, less evaporation, and larger infiltration 

depths than the same amount of rain that occurs over multiple events (Reynolds et al., 2004).  However, 

Huxman et al. (2004) found that within the Mohave, Sonoran and Chihuahuan desert regions, carbon 

fluxes within the microbial and vascular plants communities were positively affected by the quantity of 

precipitation pulses of 5mm or larger.   

Furthermore, an associated lag time exists between the rain event and the production of 

chlorophyllic biomass (Richard & Poccard, 1998; Wang et al., 2003; Ogle & Reynolds, 2004; Svoray & 

Karniel, 2010).  Svoray and Karniel (2010) found that the parameter that quantified the previous 

ŵoŶth͛s pƌeĐipitatioŶ ǀalue ǁas the ŵost sigŶifiĐaŶt iŶ eǆplaiŶiŶg the response in vegetation cover 

through Normalized Difference Vegetation Index (NDVI) derived from SPOT XS imagery (20m resolution).  

Richard & Poccard (1998) and Barbosa (2004) not only found that rainfall totals for the previous 30d 

showed a strong linear correlation to the NDVI values in Southern Africa and Northeast Brazil, but also 

the previous 60d as well, suggesting that the time-lag can be upwards of 2 months.  Similarly, Wang et 

al. (2003) used NDVI to observe a 2-4 week delay in a vegetation response following a major 

precipitation event in Kansas and desĐƌiďed the pƌeĐipitatioŶ to NDVI ƌespoŶse ƌelatioŶship as ͞stƌoŶg 

and predictable when viewed at the appƌopƌiate spatial sĐale.͟  Even so, the strength and delay in 

response to precipitation is contingent upon the vegetation type (Ogle & Reynolds, 2004).   

Remote sensing imagery is used in studies that investigate and classify vegetation spatially and 

temporally.  Landsat 5 TM has demonstrated its efficacy through its long-term accessibility, moderate 
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spatial and temporal resolution, multispectral sensors, and low cost.  For these reasons, Landsat 5 TM 

has been widely used as a successful tool in countless research studies, such as vegetation classification 

and change detection (Kerr & Ostrobsky, 2003), vegetation health (Vogelmann et al., 2009), long-term 

land cover analyses (Nguyen et al., 2014; Wang et al., 2003), and ecosystem responses (Pettorelli et al., 

2005; Barbosa et al., 2006).  NDVI, which uses the Red and Near Infrared (NIR) bands, has been 

recognized as the most used vegetation index (Kerr & Ostrobsky, 2003; Brown et al., 2006) and can be 

explicitly related to vegetation productivity (Richard & Poccard, 1998; Ichii et al., 2002; Pettorelli et al., 

2005, Brooks et al., 2011) and precipitation influences (Nicholson & Farrar, 1994; Wang et al., 2003; 

Barbosa et al., 2006).   

Many studies have related precipitation data to vegetation characteristics, but usually using discrete 

precipitation measurement stations (Wang et al., 2002, Huxman et al., 2004; Reynolds et al., 2004; 

Goodrich et al., 2008; Svoray & Karnieli, 2010).  Another option is using radar precipitation data such as 

NEXRAD or PRISM data that uses a combination of radar data with local rain gauge data or other 

relevant precipitation data (Brunsell & Young, 2008).  Radar infrastructure has been available since the 

early 1990s.  Historically, many radar-only products have had problems often rendering previous 

versions of the technology ineffectual, especially in the Western half of the US.  More recent increases in 

infrastructure (post 1997) have shown noticeable differences in the accuracy of radar data (Xie et al., 

2006).  Further development of the Multisensor Precipitation Estimator (MPE) product in 2002 and 

Mountain Mapper has increased the accuracy of the NEXRAD product by incorporating rain gauge data 

as ground truth and bias control, especially in the western half of the US (Wang et al., 2008; Wu & 

Kitzmiller, 2011).  Wu & Kitzmiller (2011) used MPE products to assess the less sophisticated, radar only 

precipitation products for the entire US from April 2009 to March of 2010.  Even though the NEXRAD 

datasets have improved dramatically since their first inception, they are still affected by spotty, mix 
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intensity rain events, mountainous terrain, and storm type (i.e. Orographic, Convective, or Frontal) and 

should be used carefully to address these effects.   
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CHAPTER 3: STUDY SITE 

 

 

 

The Department of Defense (DOD) manages approximately 35,600 km2 of US land in the arid and 

semi-arid southwest harboring a higher density of threatened and endangered species than is found on 

land of any other federal agency (Stein et al., 2008).  This research took place at the DOD installation, 

Yuma Proving Ground (YPG; Figure 1), located in the Sonoran Desert in southwestern Arizona.  YPG 

encompasses 3,367km2 of semi-arid landscape with elevations ranging from 54 to 870m (Figure 2; DEM).  

YPG receives an average of 95mm of precipitation a year during two separate rainy seasons - monsoon 

and winter season (Western Regional Climate Center, 2012).  This bimodal pattern leads to scattered 

rain events throughout the year, allowing for a unique and diverse plant community that can support 

larger woody species, such as ironwood (Olneya tesota), paloverde (Parkinsonia spp.), acacia (Acacia 

greggi), and mesquite (Prosopis spp.), as well as columnar cacti (Sutfin et al., 2014; NPS, n.d.). 

Summer precipitation is driven by monsoon rains that originate over the Mexican Plateau located to 

the southeast and create localized, high intensity storms (NPS, n.d.; National Weather Service, n.d.).  

Large swaths of desert pavement coupled with low vegetation densities within the uplands allow rain 

water to move easily into stream channels (Figure 2), causing short-lived flow events.  In contrast, 

winter precipitation originates from frontal storms typically from December to March that develop over 

the Pacific Ocean and tend to deliver more widespread, less intense and longer-lasting rainfall events, 

leading to higher infiltration rates with less runoff (Snyder & Tartowski, 2006; Stromberg et al., 2007).  

An increase in cloud cover coupled with cooler temperatures decreases the evapotranspiration rates 

allowing rain water to remain available to vegetation for a longer time.  Many plant and animal species 

rely on the combination of these two rainy seasons that result in varying degrees of dependence.  The 

precipitation quantities and frequencies can have profound effects on the vegetation composition over 

annual and decadal intervals (Snyder & Tartowski, 2006).  Inter- and intra- annual climatic variability can 
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…..“paĐe FILLE‘ …………………………………..“paĐe Filleƌ …………………..“paĐe Filleƌ…………….    

Figure 1:  Location map of YPG. Inset A: Yuma Wash – Jan 2011 (UTMs: 11S 3664132m N, 731326m E).  

Inset B: Mohave Wash – Jan 2011 (UTMs: 11S 3698644m N, 737959m E).  Pictures courtesy of Lainie 

Levick.   
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 support a diverse set of vegetation, i.e. herbaceous plant seed can endure for multiple years until the 

right conditions exist to initiate growth (Bowers et al., 2004) or large flood events can promote tree 

recruitment and seedling success (Friedman & Lee, 2002).  Furthermore, Sutfin et al. (2014) describes 

five general channel types that occur within this area: piedmont headwaters, bedrock, bedrock with 

alluvium, incised alluvium, and braided channel types.  These stream types can be differentiated by the 

channel geometry, width-to-depth ratio, slope, stream power, and shear stress and thus can have an 

underlying influence on the vegetation within this area (Sutfin et al., 2014). 

Figure 2: 10m DEM of YPG. 
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CHAPTER 4: METHODS 

 

 

 

The following sections describe the methods used in creating this analysis and are illustrated in 

Figure 3.  The first phase modified the data to be used in this study (Figure 3-A).  This involved deriving 

the Riparian Area Polygons (RAPs) from the NHDPlus Version 2 dataset.  The next step required 

processing the NDVI from the Landsat images, subtracting paired NDVI scenes ;ΔNDVI-S), followed by 

extracting the mean NDVI value of the top ten percent of pixel values (MTT) within each RAP unit for 

eaĐh ΔNDVI-S.   The second phase (Figure 3-B) investigated the precipitation datasets using linear 

regressions to assess the validity of NEXRAD radar and PRISM data as a proxy for precipitation within 

each rainy season.  The data was then organized between the monsoon and wiŶteƌ seasoŶ͛s ďased oŶ 

the linear regressions from Figure 3B and the monsoon dataset was compared to two known flow 

events (Figure 3-C).  For the Results and Conclusions (Figure 3-D), mean and coefficient of variation (CV) 

were used to determine the spatial uniformity and temporal variability of the changes in monsoon 

seasoŶ NDVI oǀeƌ the Ϯϲ Ǉeaƌ studǇ peƌiod.  “peaƌŵaŶ͛s ĐoƌƌelatioŶ aŶalǇses ǁeƌe used to ƌelate ǁiŶteƌ 

precipitation measured via radar instruments to the changes in NDVI over corresponding localities and 

timescales.  A final analysis was created that combined the monsoon and winter season analyses.  These 

methods are described in more detail in Appendices B & C.  A list of abbreviations are shown in Table 1. 

4.1 Riparian Area Polygons (RAPs) 

RAPs were derived from the NHDPlus Version 2 

flowlines for the Lower Colorado Vector Processing Unit 

(www.horizon-systems.com/NHDPlus/ NHDPlusV2_15 

.php).  The NHDPlus Version 2 flowline layer was split into 2,843 reaches at approximately 1km or 

smaller lengths (Levick et al., 2015).  Each reach was inundated to a height of 3m using a 10m DEM and 

Table 1: List of Abbreviations. 

Change in NDVI Scene (post – 

pre) for each rainy season 
∆NDVI-S 

Mean of Top 10% (NDVI) per RAP MTT 

Near Infra-Red Band (Band 4) NIR 

Riparian Area Polygon RAP 

Yuma Proving Ground YPG 

 

http://www.horizon-systems.com/NHDPlus/%20NHDPlusV2_15%20.php
http://www.horizon-systems.com/NHDPlus/%20NHDPlusV2_15%20.php
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Figure 3:  Flow Chart showing the Methods used and are segmented into four steps A, B, C, and D. 
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the HGVC (Hydro-Geomorphic Valley Classification) extension tool (Carlson E.A., 2009) in ESRI ArcMap 

10.2, and the inundated area was mapped to a maximum distance of 200m from the original flowline.  

Each RAP (Figure 1: blue polygons) was labelled with a unique identifier.   
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4.2 Landsat TM  

Landsat TM scenes from Path 38, Row 37 were acquired thƌough U“G“͛s GloďeVis ǁeďsite 

(http://glovis.usgs.gov/) for pre- and post-monsoon season dates for years 1986 – 2011 (26 total) and 

from October to April for winters from 2004-05 to 2010-11 (seven total).  In all cases, Landsat 5 TM 

images were selected except during 2000–02 monsoon seasons where Landsat 7 TM provided superior 

images.  Additional scenes were acquired for the 1989 (Landsat 5 TM) and 2013 (Landsat 8 TM) 

monsoon seasons to relate the change in NDVI to recorded flood events.  Acquisition dates and 

identification codes for each scene are documented in Appendix A. 

Each Landsat scene underwent pre-processing in ENVI 5.0 where Radiometric Calibration for 

Reflectance and Dark Object Subtraction were executed on all scenes.  Each Landsat scene was masked 

to the study area where the pixels were spatially aligned and the cell size was reduced to 5m2 to ensure 

that smaller RAPs would capture all NDVI values.  NDVI was calculated for individual scenes using the 

standard equation [(NIR – RED) / (NIR + RED)] in ARCMap 10.2.  The base scene for each of the 26 

monsoon seasons was chosen during June or July, with one exception in May (1996).  The base scene 

selected for each of the seven winter seasons was captured prior to the winter season in either 

September or October.  The monsoon season NDVI base scene was subtracted from the post-monsoon 

season NDVI imagery of that year and the base winter NDVI scene was subtracted from all subsequent 

winter scenes for each of the seven winter seasons.  This created the change in NDVI scene for each pair 

of dates ;heƌeafteƌ ƌefeƌƌed to as the ∆NDVI-S) where positive values indicate a gain in NDVI.  The 

moŶsooŶ seasoŶ ∆NDVI-S results are located in Figure 7 in section 5.1.  Further details are described in 

Appendix B. 

 

http://glovis.usgs.gov/
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4.3 Mean of the Top Ten Percent (MTT) values  

The ƋuaŶtitǇ of ĐhaŶge iŶ NDVI of the ŵoŶsooŶ aŶd ǁiŶteƌ ∆NDVI-S were extracted at each RAP to 

determine the increase in plant biomass during the selected rainy seasons.  This was done by taking the 

mean value of the pixels above the 90th percentile.  The 90th percentile was chosen to estimate the 

increase in NDVI because the RAP units typically incorporate 50 to 500, 30x30m pixels with many non-

vegetative pixels associated with them.  Taking the mean of all pixels within the RAP unit would be 

meaningless and using the maximum value would misrepresent the increase in NDVI, therefore the 

mean value of the top ten percent was used.  This was executed by clipping the individual 2,843 RAP 

uŶits to eǀeƌǇ ∆NDVI-“.  Afteƌ a siŶgle ∆NDVI-S image was masked to the 2,843 individual RAPs, the 

newly created RAP raster images were changed into ASCII text files.  A python script (Appendix B) was 

used to extract the NDVI values from each RAP ASCII text file, then calculate the Mean value of the Top 

Ten percent (MTT).  The python code aggregated each MTT value for the 2,843 RAPs into a single CSV 

file ďased off the ∆NDVI-S used (Figure 4).  

A B 

Figure 4: These figures demonstrate the methods for extracting the MTT NDVI values within each RAP.  

Foƌ eaĐh ∆NDVI-S, each RAP was extracted separately by using individual RAP shapefiles in ArcMap 10.2 

(shown in Figure A), then converted into an ASCII text file that contains every pixel value within the 

RAP.  The values of the pixels representing the Top 10% are depicted in Figure B.   
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The MTT values were further manipulated on the monsoon season dataset to calculate the slope 

(change in NDVI per day) using the total number of days between pre- and post-monsoon season 

iŵageƌǇ.  This ǁas doŶe oŶ eaĐh ‘AP uŶit foƌ eaĐh ΔNDVI-S during the monsoon season.  Coefficient of 

variation (CV) was also calculated for each of the 2,843 RAPs by taking the standard deviation of the 26 

years of MTT values then dividing it by the mean.  Two flood events were recorded within the study area 

during the 1989 and 2013 monsoon seasons.  Nearby RAP units (n=52 and 10, respectively) were 

isolated aŶd the ŵediaŶ of the MTT ǀalues ǁeƌe ĐalĐulated foƌ seǀeƌal ΔNDVI-“͛s ďƌaĐketiŶg these 

events. 

4.4 Rain Gauge Data 

Rain gauge data were acquired through 

the National Weather Service Forecast 

Center (http://www.wrh.noaa. 

gov/twc/monsoon/monsoon_yum.php) for 

Yuma, Arizona from 1876 to 2014 and GHCN 

data were attained through the NOAA 

National Climatic Data Center website 

(http://www.ncdc .noaa.gov /data-

access/land-based-station-data) at six 

locations within and surrounding YPG with 

scattered coverage as early as 1909 (Figure 5; crosses).  A second group of rain gauges were acquired for 

Yuma (YBA, YBD and YIA) and Mohave Washes (MBD and MBA) (Figure 5; drops) and measured rain 

events from 2011 to 2013 (Faulconer, 2015).  The instruments used at Yuma and Mohave Washes were 

a TE 525 Tipping Bucket rain gauge system at 0.254mm per tip rate. 

Figure 5: Rain gauges distributed through YPG and 

the surrounding area. 
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4.5 Radar Data  

NEXRAD data are a type of Doppler radar that measure precipitation amounts from fixed stations 

located throughout the US and estimates precipitation up to a range of 230km from each station 

(Fulton, 2002).  Radar emits a signal that increases in altitude with increasing distance causing the radar 

station to sample higher altitudes that do not necessarily represent what is occurring at the surface.  

Previous versions of NEXRAD (Stage II & III) data led to the creation of the Multisensor Precipitation 

Estimator (MPE) that combines Stage II data and independent rain gauge data with satellite precipitation 

data (GOES Satellite imagery) to produce more accurate precipitation estimates by minimizing local bias 

errors and enhancing coverage by decreasing beam blockage and reducing spatial uniformity with rain 

gauge data (Fulton, 2002).  Mountain Mapper is similar to MPE, but is used in areas that are affected by 

orographic precipitation, commonly in the western US (Schaake et al., 2004).  NEXRAD MPE and 

Mountain Mapper products are processed through the National Weather Service: River Forecast Centers 

since 2004.  The precipitation data are delivered in the Hydrologic Rainfall Analysis Project (HRAP) grid at 

a 16km2 resolution in inches. 

The NEXRAD station YUX covers YPG and resides southwest of the boundary (Appendix C, Figure 22).  

The rain gauge sites for Yuma Wash were located approximately 80km away, while Mohave Wash rain 

gauge sites reside about 125km away.  The NEXRAD data were downloaded from the National Weather 

Service website (water.weather.gov/precip/p_download_new) by using a python script created by 

Mehmet Ercan (http://mehmetbercan.com/scripts/scriptsGIS.html) that downloads and clips the 

NEXRAD data in Esƌi͛s ArcMap.  It was further processed into tabular format of daily precipitation totals 

per each virtual grid point beginning on January 2, 2005.   

Since the NEXRAD data that were used began on January 2, 2005, during a particularly wet winter 

season, PRISM precipitation data were used to estimate the rainfall prior to January 2, 2005 for the 

http://mehmetbercan.com/scripts/scriptsGIS.html
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2004-05 winter season.  PRISM precipitation totals and temperature mean data were downloaded 

through the PRISM CLIMATE GROUP from October 2004 through April 2011 in daily ASCII files for the 

contiguous US (http://www.prism.oregonstate.edu).  The resolution is identical to the NEXRAD data 

(16km2). 

4.6 Precipitation Instrument Comparative Analysis 

The precipitation instrument comparative analysis was executed on the rain data initially to 

determine the direction of the primary analyses and therefore the methods and results are documented 

here.  Rain gauge data were compiled with NEXRAD and PRISM precipitation data to assess the quality 

of these datasets.  The three rain gauge sites at Yuma Wash and the two rain gauge sites at Mohave 

Wash (Figure 5), were used to evaluate the radar derived data.  Inverse Distance Weighting was applied 

to the three or four closest NEXRAD and PRISM grid center points to estimate the two observed 

precipitation datasets at each of the five rain gauge sites.  Linear regressions performed in RStudio 3.1.1 

(R Core Team, 2014) on the NEXRAD and Rain Gauge datasets for years 2011-13, showed a stronger 

relation with winter precipitation (Table 2; adjusted R2: 0.81 & 0.84) than with annual precipitation 

(Table 2; adjusted R2: 0.18 & 0.34).   Moreover, the slopes of the linear regressions showed similar 

results.  Yearly data showed that NEXRAD radar data greatly underestimated the actual rainfall, where 

slopes for Yuma and Mohave washes were 0.15 and 0.38, respectively (Table 2).  Slopes configured from 

      Table 2:  Linear regression results relating to the various daily precipitation total data. 

   Rain Gauge vs NEXRAD Rain Gauge vs PRISM NEXRAD vs PRISM 

 Site 
Rain 

Events 

Mean 

Slope 

Mean 

Adj R2 

Mean 

Slope 

Mean 

Adj R2 

Mean 

Slope 

Mean 

Adj R2 

Y
e

a
r Yuma Wash 215 0.15 0.18 0.17 0.21 1.00 0.64 

Mohave Wash 162 0.38 0.34 -- -- -- -- 

W
in

te
r Yuma Wash 88 0.56 0.81 0.60 0.69 -- -- 

Mohave Wash 69 0.63 0.84 -- -- -- -- 
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the linear regressions on the winter data alone showed improvements (Yuma: 0.56 and Mohave: 0.63; 

Table 2), however, these data indicated that NEXRAD radar data generally underestimates the actual 

rainfall by approximately 40%.  A similar trend followed for the PRISM datasets when compared to the 

Yuma Wash rain gauge sites (winter adjusted R2: 0.69 and year adjusted R2: 0.17).  Linear regressions 

calculated on yearly data from 2005-13 combining the NEXRAD and PRISM datasets found that the 

average adjusted R2 value was 0.64 for all years with a slope of 1.00.  Because the NEXRAD data uses 

Greenwich Mean Time, any precipitation event that occurred after 6 pm at YPG was recorded the day 

after.  Consequently, the NEXRAD data were moved to the day after when appropriate.  PRISM data saw 

similar discrepancies, but not as frequently.  For more detail on these analyses, refer to Appendix C. 

4.7 Combining NDVI and Precip/Temp Interval Data  

Since the linear regression calculations concluded that NEXRAD radar data is more accurate during 

winter than summer, correlation analyses using NEXRAD were limited to the winter.  Precipitation, mean 

temperature data, and change in NDVI were organized at YPG starting in October and going through 

early May for each of the seven winter seasons.  The precipitation data used NEXRAD daily observation 

data for all years except from October 1, 2004 to January 1, 2005 where PRISM precipitation daily totals 

were used.  All temperature data came from the PRISM datasets and changes in NDVI data were derived 

from the Landsat imagery by taking the MTT values at every RAP unit foƌ eǀeƌǇ ∆NDVI-S.  The total 

precipitation and temperature mean data were organized in the previous 4, 8, 16, 32, 48, 64, and 96 day 

intervals as well as a season interval for every Landsat winter scene date.  Earlier winter scenes had null 

values in the larger day interval data.  Number of days with precipitation totals above 5mm and 10mm 

were totaled for every winter Landsat scene for the previous 32, 48, and 96 day intervals.  To better 

investigate the time-lag, precipitation amounts were totaled between two select dates for the intervals: 

8-16, 16-32, 16-48, 32-64, and 48-96 days prior to the more recent Landsat scene capture date. 
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CHAPTER 5: RESULTS & DISCUSSION 

 

 

 

5.1 Monsoon Season  

The Sonoran Desert encounters a monsoon season usually between July and September that tends 

to experience high intensity thunderstorms.  Though infrequent, these storms can deliver significant 

quantities of precipitation into the ephemeral stream channels and are likely to be spatially and 

temporally irregular where gaps between storms may span many years.  However, the true patchiness 

of monsoon type storms is not well understood due to spatially and temporally inadequate datasets 

(usually from sparse rain gauge data or inaccurate RADAR data; Wang et al., 2008).  The response in 

NDVI to precipitation may indirectly prove to be superior and more reliable at investigating these 

patteƌŶs thaŶ the afoƌeŵeŶtioŶed data tǇpes.  The ďoǆplots fƌoŵ Figuƌe ϲ aŶd the ∆NDVI-S plates from 

Figure 7 shows the changes in NDVI at YPG for each monsoon season from 1986 to 2011.  The strength 

of these changes as well as the spatial variability indicates the spatial and temporal scales at which 

monsoon season storms influence this landscape.   

Figure 6: Boǆplots foƌ ∆NDVI-S along the 2,843 RAPs for all monsoon season study years. 
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“PACE FILLE‘.... “PACE FILLE‘ … “PACE FILLE‘ … “PACE FILLE‘ … “PACE FILLE‘ …. “PACE 

……………………       

      Figure 7:  ChaŶge iŶ NDVI sĐeŶes ;∆NDVI-S) for monsoon season years 1986 to 2011. 
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The ďoǆplots fƌoŵ Figuƌe ϲ aŶd ∆NDVI-S plates from Figure 7 indicate that 1986, 1988, 1990 and 

1997 have higher than average changes in NDVI with median MTT values for all RAP units at 0.049, 

0.052, 0.047, and 0.077, respectively, with the 1997 monsoon season showing the strongest overall 

NDVI signal.  The significant MTT value seen in 1997 is likely due to the strong and rapid increase in El 

Niño conditions that occurred prior to the 1997 monsoon season 

(www.pmel.noaa.gov/tao/elnino/faq.html#deal).  However, 1997 did not have the maximum MTT value 

for this dataset.  The maximum MTT value among all RAP units occurred during the 1999 monsoon 

season at an increase in MTT of 0.342 in the southwestern portion of YPG.  In contrast, the MTT values 

from the 2005 monsoon season (Figure 6) shows a decrease in NDVI along several RAP units resulting 

from a fire that burned through YPG and the KOFA National Wildlife Refuge preserve to the north (Esque 

et al., 2013).  The minimum MTT value during this year is -0.046 and serves as the lower limit of the 

1986-2011 dataset.  A strong negative MTT change (< -0.02) is atypical during the wet season and when 

observed, it is likely the result of a significant land cover change.  Monsoon season 2010 saw few 

changes with some negative MTT values.  Unfortunately, this is likely the relic of an early post-monsoon 

season image of September 5, 2010.  A better choice would have been a later image, but later scenes 

had considerable cloud cover over the study area.  What is apparent from the cloud-free portions of the 

October 7, 2010 images is that that the monsoon season appears to be more similar to other monsoon 

seasons than is depicted from the September 5, 2010 image.  This example illustrates the importance of 

selecting the best available dates while considering the cost of cloud cover versus the impact of change 

in NDVI.  Other years that may be inflicted by earlier than desired post-monsoon season imagery include 

1995, 2001, 2003, and 2011 (Figure 6). 

 

 

http://www.pmel.noaa.gov/tao/elnino/faq.html#deal
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5.1.1 Testing the MTT values  

The MTT values from 52 RAP units that surrounded the NCDC rain gauge 3125 were associated to 

the precipitation record at the rain gauge site for each monsoon season between 1986 and 2011, 

excluding 2009 when the rain gauge lacked data (Figure 8).  Using RStudio 3.1.1 (R Core Team, 2014), a 

linear regression was completed over the 25 monsoon seasons using the precipitation and NDVI data.  

Precipitation was totaled between the pre- and post-monsoon season dates for each season, however 

to account for a time-lag period between rainfall and vegetation growth, precipitation that was 

recorded within the 12d prior to the post-monsoon season date were excluded.  The adjusted R-squared 

value determined from these data equaled 0.73 suggesting that the MTT values are a good indicator of 

precipitation inputs.  Furthermore, the slope of the linear regression amounted to 0.0007, thus 

suggesting that 10mm of rainfall will increase the MTT values by roughly 0.007 (Figure 8). 

Figure 8:  Linear regression comparing the total precipitation during monsoon seasons 1986 - 2011 

at rain gauge 3125 to nearby RAPs.  The median MTT value of the 52 RAPs were taken for every 

ΔNDVI-S and were regressed on the precipitation totals at the rain gauge.  R2 was found to be 0.73 

with a slope of 0.0007. 
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5.1.2 Relating the MTT values to Precipitation 

There have been many studies that have established the robust relationships between precipitation, 

plant productivity, and NDVI (Nicholson & Farrar, 1994; Wang et al., 2003; Pettorelli et al., 2005; 

Barbosa et al., 2006; Brooks et al., 2011).  In this research, the Linear Regression shown in 5.1.1 further 

documents the strong relationship between the MTT values used here to precipitation.  Additional 

parameters that may better explain the relation between monsoon season precipitation and NDVI are 

precipitation timing and intensity, temperature, and channel location.  A negative change indicates that 

little or no rainfall has fallen and/or that persistent higher temperatures have caused noticeable 

decreases in plant productivity.  A zero or near zero change indicates either that few rainfall events have 

occurred or that vegetation does not persist in the pixelated area.  A positive change indicates that 

rainfall contributed to an increase in plant productivity and a large positive increase in NDVI suggests 

that the riparian area was not only influence by a rain event, but also by a flow event that allowed more 

rainfall to accumulate within the riparian areas triggering considerable increases in vegetation growth.  

The rain gauge data acquired from the Strategic Environmental Research and Development Program 

(SERDP) RS-1725 grant funded project at Mohave Wash (Faulconer, 2015) aŶd NOAA͛s GHCN ƌain gauge 

3125 (Figure 5), has allowed a more detailed investigation into the change in NDVI following two flow 

events (Figures 9 & 10).  During the summer of 1989, the GHCN 3125 rain gauge recorded a 61mm rain 

event on August 9 (Figure 9).  Although it is unclear how much precipitation occurred in the surrounding 

area, the strong change in NDVI following this event indicated this event to be fairly large.  It can also be 

assumed that even though no flow data were measured during this event, a 61mm monsoon rain event 

would surpass upland infiltration rates and produce runoff.   

The same pre-monsoon season scene used for the 1989 monsoon season analysis was used here 

(June 23, 1989) to track the changes in NDVI during this season.  The 52 RAPs that were used in the 
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linear regression in 5.1.1 were used here to measure the increase in NDVI following this large rain event 

(Figure 9: Landsat Plates).  The MTT values documented a sudden increase in NDVI 18 days following the 

flow event (Figure 9; ΔNDVI/daǇ gƌaphͿ.  The Landsat scene taken on July 25, 1989 prior to the rain 

event, documented a slight increase (0.0027) in the median MTT values for the 52 RAP units.  However, 

the median of the MTT values foƌ the August Ϯϲ, ϭϵϴϵ ΔNDVI-S increased by 0.057, increasing the slope 

to 0.0017 ΔNDVI/daǇ between July 25 and August 26, 1989.  This is seen from the two graphs in Figure 

9.  Following August 26, 1989, the increase in NDVI declined suďstaŶtiallǇ to Ϭ.ϬϬϬϮ ΔNDVI/daǇ foƌ the 

Ŷeǆt ŵoŶth aŶd Ϭ.ϬϬϬϯ ΔNDVI/day over the following month.   

When relating these data to the entire monsoon season, the strong change in NDVI following a flow 

eǀeŶt is gƌeatlǇ diŵiŶished ;Ϭ.ϬϬϬϲ ΔNDVI/daǇ iŶĐƌease ďetǁeeŶ JuŶe Ϯϯ aŶd OĐt Ϯϵ, ϭϵϴϵ; Figure 9).  

Even though the increase is not as substantial when considering the entire season, it is still likely to be 

strong enough to indicate that a flow event has occurred during that season.  From these data, I suggest 

that aŶ iŶĐƌease iŶ Ϭ.ϬϬϬϲ ΔNDVI/daǇ oƌ gƌeateƌ iŶdiĐates a high probability that flow occurred along 

RAP units or if not flow then likely the RAP units were influenced by multiple and also significant rain 

events.  

Similar results are seen during the 2013 flow event at Mohave Wash (Figure 10) using the median 

MTT values of the 10 closest RAP units.  The rain gauge recorded a 52.6mm rain event on September 7, 

2013 with smaller rain events occurring before and following the 52.6mm rain event.  Furthermore, field 

observations within the following month indicated flow had occurred within the stream channel (Joshua 

Faulconer, personal communication).  Unlike the 1989 event, the increase in NDVI within the 

surrounding area, suggests that this event was considerably smaller and therefore only 10 RAPs were 

used to show the change in NDVI.  Because several other rain events were recorded at the Mohave 

Wash rain gauge during the 2013 monsoon season, the NDVI showed a fairly steady increase (Figure 10; 
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Figure 9: The 1989 flow event and NDVI Comparison.  The GHCN 3125 rain gauge recorded a 

large rain event (61mm) on August 9, 1989.  Considerable increase in NDVI over a spatially large 

area indicates that this rain event covered a relatively large region (radius >15km).  Changes in 

NDVI were recorded for 52 reaches over the 1989 monsoon season.  The largest change in NDVI 

occurred within the first 18d following the flood event (s=0.0017).  The average slope between 

Jun 23 and Oct 29 (128d) is 0.0006. 
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Figure 10: Mohave Wash (2013) flow event and NDVI Comparison.  Rain gauge data recorded a 

large quantity of precipitation on September 7, 2013 (52.6mm), soil moisture data and field 

observations in October of 2013 indicated a flow event (re-working of channel and distribution 

of debris).  Following this event,  the largest gain in NDVI values were seen between 6 and 22 

days following the event (slope = 0.0011) and decreased to 0.0007 after 38d.  The average 

slope between Jul 27 and Oct 31 (96d) is 0.0006.  These reaches have a Contributing Area of 

approximately 170km2. 
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ΔNDVI/daǇ gƌaphͿ.  BetǁeeŶ “epteŵďeƌ ϭϯ aŶd Ϯϵ ;ϲ to 

22d following the flow event), the rate of increase rose 

fƌoŵ Ϭ.ϬϬϬϯ to Ϭ.ϬϬϭϭ ΔNDVI/daǇ.  BetǁeeŶ “epteŵďeƌ 

29 and October 15 (22 to 38d following the event), the 

ΔNDVI/daǇ deĐƌeased to Ϭ.ϬϬϬϳ.  Afteƌ October 15 and 

ϯϴ daǇs folloǁiŶg the floǁ eǀeŶt, the ΔNDVI/daǇ 

decreases considerably to 0.0002.  When averaging the 

slopes across the entire monsoon season, an average 

slope of Ϭ.ϬϬϬϲ ΔNDVI/daǇ is seeŶ aŶd is ideŶtiĐal to the ϭϵϴϵ data.  “iŶĐe the ϮϬϭϯ flow event showed 

several other rain events that likely facilitated the overall increase in slope to 0.0006, this could denote 

that the threshold for indicating a flow event with high certainty may actually be lower than 0.0006 

ΔNDVI/day. 

Slopes were calculated for all RAP units during the 26 Monsoon seasons (Figure 11).  For this analysis, 

the ideal number of days between scenes is either 96 or 112 and accounts for 21 monsoon seasons 

(Table 3).  Figure 11 shows the percentage of slopes that is above the 0.00Ϭϲ ΔNDVI/daǇ thƌeshold ǁith 

the largest percentage occurring in 1997 with over 73% of the RAPs surpassing the 0.0006 threshold.  

This suggests that not only did a significant rain event or events occurred, but the coverage was more 

uniform than is typical during the monsoon season.  Other notable years with higher percentages were 

1998 at 31%, 1986 at 23%, 2004 at 21%, 1989 and 1990 at 13%, 2009 at 12% and 1999 at 11% (Figure 11). 

The slopes of the MTT values for each RAP were averaged over the 26 monsoon seasons and are 

displayed in Figure 12.A.  Inclusion of the 2010 monsoon season that had an early post-monsoon season 

imagery, did not vary these results considerably.  RAP units with greater average slopes indicates that 

these reaches had more frequent increases in NDVI, suggesting that they received more monsoon season 

Table 3:  Number of days between pre- and 

post-monsoon season Landsat scenes for 

each year.  

# Days Tally Years 

64 1 2010 

80 1 2011 

96 14 
1989, 1991, 1993-95, 

1997, 1999-04, 2006-07 

112 7 
1987-88, 1992, 1998, 

2005, 2008-09 

128 2 1986, 1990 

160 1 1996 
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precipitation over the 1986 to 2011 study period.  Of the 2,751km of stream channels at YPG, 

approximately 8% have an average slope between 0.0001-0.0002, 43% between 0.0002-0.0003, 36% 

between 0.0003-0.0004, 10% between 0.0004-0.0005, and 3% between 0.0005-0.0010.  Figure 12.A 

shows that the mountainous terrain located in the western portions of YPG (refer to Figure 2; DEM), tend 

to have on average greater changes in NDVI/day within the mountains than in flatter terrain and also 

shows that as distance increases from the mountain ranges, slopes generally decreasing.  This is expected 

given that these channels suffer from high transmission losses (Goodrich et al., 2008).  Slopes of 

individual ΔNDVI-S are found in Appendix E.    

The CV among RAPs for the 26 year study period are also shown in Figure 12.B.  The CV explains the 

variability of changes in NDVI at YPG.  Lower CV values (CV>1) suggest that there have been less changes 

and higher values (CV<1) imply that the RAPs experience greater changes in NDVI.  From Figure 12.B, it is 

apparent that the eastern portions of YPG have experienced more variability than the western portions.  
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Figure 11: Boxplots of the Slope of each RAP unit over the 26 monsoon seasons.  The 0.0006 
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Figure 12: A: The slope ;∆NDVI/daǇͿ of the MTT ǀalues at eaĐh ‘AP ǁeƌe aǀeƌaged oǀeƌ the Ϯϲ monsoon seasons.  A larger slope 

indicates that there was on average higher increases in NDVI at that reach over the 26 years.  B: The Coefficient of Variation (CV; 

standard deviation/mean) indicates the variance over the timeframe, where low CV values (CV < 1) suggests there was little change over 

the 26 monsoon seasons, while greater CV values (CV > 1) suggests that RAPs have higher variability in changes in NDVI between pre- 

and post-monsoon season images. 
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Some of the RAPs with a CV greater than 1.5 are in the region that was affected by the 2005 fire.  This 

region is also supplied by a large mountain range in the KOFA National Wildlife Refuge preserve to the 

north and under the right conditions can experience large flow events.  The distance of these channels 

from the mountain range also causes this region to undergo high transmission losses.  This may explain 

why the southeastern portion of YPG sees higher variability in NDVI from 1986-2011 than the other 

regions.  The mountainous region in the western portion of YPG may see more consistent weather 

patterns due to orographic effects, thus depicting lower CV value. 

5.2 Winter Season 

For the seven winter seasons examined, the 2004-05 season experienced more rainfall and more 

rain events than any other year.  The NEXRAD/PRISM data measured approximately 140.5mm averaged 

over RAP units and NCDC rain gauge 3125 measured a total of 240mm of rainfall from September 1, 

2004 to March 31, 2005 with 13 days measuring more than 5mm of rainfall, eight of which surpassed 

10mm of precipitation.  This is also apparent in the strong increase in MTT values that were recorded for 

this year (Figure 15 & Appendix D).  There were also considerable increases in the MTT values during the 

winters of 2008-09 and 2009-10 where the NEXRAD radar data (averaged over RAP units) recorded 

approximately 37.4 and 105.5mm, respectively.  The strong increase in MTT values for the 2008-09 

winter may suggest that the 37.4mm average precipitation total is greatly underestimated or there were 

other variables such as temperature or precipitation timing and intensity that led to such high MTT 

values for this year.  The 2009-10 winter season experienced rainfall later in the season which caused a 

delayed increase in the MTT values.  It could also be expected that the MTT values would have further 

increased in the 2009-10 season, however two March scenes were left out due to significant amounts of 

cloud cover.   
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The remaining winters showed only slight changes in the MTT values (Figure 15 & Appendix D).  The 

2005-06 and 2006-07 winters experienced the earliest gain followed by a decrease in the MTT values 

suggesting a late monsoon season then followed by little winter precipitation.  Lastly, the 2007-08 and 

2010-11 seasons experienced few scattered rain events with minor gains in MTT values throughout the 

season.     

In all cases, except for two, consecutive ΔNDVI-S͛s were found to be statistically different (p-value < 

0.001; Appendix D, Table 10).  This was tested through Paired T-Tests and when necessary the non-

parametric Wilcoxon signed rank test between each 2,843 RAP unit of the two consecutive ΔNDVI-“͛s.  

The dates that were found not to be statistically different from each other are February 17 - April 6, 

2007 and February 25 - April 14, 2010.  In both cases, a statistical difference may have been detected if a 

cloudless Landsat scene was available in March of each year.   

5.2.1 Correlation Analysis 

Using RStudio 3.1.1 (R Core Team, 2014), a “peaƌŵaŶ͛s CoƌƌelatioŶ foƌ ŶoŶ-normal data was 

performed to determine the average time-lag between rainfall and an increase in NDVI using the MTT 

values for each season (Figure 13).  The “peaƌŵaŶ͛s CoƌƌelatioŶ ǁas also Đoŵpleted oŶ a combined and 

subset of dates (documented in Table 4) for all seven seasons (Figure 14).  The “peaƌŵaŶ͛s CoƌƌelatioŶ 

from Figure 13 shows that the MTT values have varying degrees of correlation to the precipitation-

temperature interval data and vary significantly depending on the year. 

Figure 13 shows that during the wettest season (2004-05), the increase in MTT values best 

correlates with the 32d precipitation total (0.69), where longer time intervals show no significant 

increases in correlation and may be attributed to fast growing herbaceous annuals that were abundant 

during this season (Esque et al., 2013).  Other highly correlated variables for the 2004-05 winter season 

include the 16-32d precipitation interval (0.76) , rain events with >5mm at the 48d interval (0.66), and 
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events >10mm at the 96d interval (0.74).  During drier winters (2005-06 & 2006-07), there was a strong 

negative correlation (-0.61 & -0.79, respectively) at both the 48 and 64d precipitation intervals and a 

weak correlation for precipitation totals at the 4, 8, 16, and 96d intervals.  Winters 2007-08 and 2010-

11 were average in total rainfall and concluded that the 48d at 0.63 (2007-08) and 64d at 0.43 (2010-

11) showed the highest correlation.  2010-11 also showed a relatively strong correlation to the >10mm, 

48d interval (0.59).  Surprisingly, the 2008-09 season, had similar rainfall totals to the 2007-08 and 

2010-11 but showed a much stronger increase in MTT values (Appendix D).  The radar precipitation 

data for 2008-09 documented two early season rain events (late November and mid-December) with a 

mean of 10mm or higher across the RAP units and one with a mean >5mm in early February.  The 2008-

09 NDVI data is best correlated at the 96d precipitation interval (0.64) and number of rain events 

>5mm during the previous 96d interval (0.67), but rain events >10mm only received a correlation of 

    Figure 13:  “peaƌŵaŶ͛s CoƌƌelatioŶ of the ǁiŶteƌ MTT data aŶd PƌeĐip/Teŵp IŶteƌǀal Data. 
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0.43 at the 96d interval.  The increase in MTT values for this year are intriguing and may suggest that 

the NEXRAD data greatly underestimated the true rainfall or that other factors are involved, however 

temperature does not seem unusual for this year.  Another possibility for the substantial increase in 

MTT during the 2008-09 season is due to the larger concentration of rain events recorded than during 

the 2007-08 and 2010-11 seasons.  

The 2009-10 period was the only season to have a positive correlation between mean temperature 

and the MTT values for the 4-64d intervals.  This is likely the result of not necessarily a winter with 

below average temperatures, but the strong increase in NDVI in February, which is later than the other 

seasons.  These data suggests that the plants not only took advantage of late precipitation, but also 

cooler temperatures that occur in December, January and February of 2009-10 (Appendix D: Mean 

Monthly Temperature Graph).  By coincidence, several significant rain events were captured within the 

4d interval for the 24-Jan-10 date and caused poor correlation (-0.50) for the smaller precipitation time 

intervals which increases in the larger time intervals with the season documenting the strongest 

correlation at 0.38.  This indicates that there is a substantial time delay from rainfall to vegetative 

growth.  The strongest positive correlation for the 2009-10 season occurred at the 32-64d Between 

Range interval (0.62). 

While the variation among years is important to recognize, the aggregation of each season may be 

most relevant.  When all seasons are combined (Figure 13 & 14; black diamonds), the correlation of MTT 

values doubles between the 16d and 32d precipitation intervals.  Although, the correlation continues to 

grow in longer time-steps: 64d (0.58) and 96d (0.62) precipitation intervals, the increase is not as strong 

as in the initial 32d interval.  This is comparable to the Svoray & Karnieli (2011) results that show the 

highest correlation for winter precipitation in a semi-arid climate to be at a month interval.  The rates of 

increases and strengths of correlation suggests that the time delay for the utilization of winter 

precipitation by plants varies.  Ogle & Reynolds (2004) recognize that deep-rooted tree or shrub species 
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will likely have a more gradual response to precipitation 

than shallow-rooted plant species.  This could also imply 

that during the winter season initial plant growth occurs 

between two to four weeks following a rain event, but 

plants will continue to produce biomass, though at a 

lesser rate up to three months following the rain event. 

Huxman et al. (2004) described rain events of 5mm 

or greater as significant where 5mm served as a 

threshold when relating to plant activity.  Here, the total 

number of rain events 5mm or larger showed significant 

correlation especially at the 96d interval (0.63) and 

average for events >10mm at the 96d time step (0.47).  

This slight discrepancy could indicate that rain events of >10mm are less frequent than events of >5mm 

 

 
Figure 14:  “peaƌŵaŶ͛s CoƌƌelatioŶ of the ǁiŶteƌ seasoŶ ;Combined Season Dates) and using late 

January to end of March scenes (Combined Late Season Dates). 

 

 Table 4:  Dates used in correlation analyses. 

Combined Season Dates 

Combined 

Late Season 

Dates 

25-Dec-04 27-Feb-05 27-Feb-05 

15-Mar-05 31-Mar-05 15-Mar-05 

16-Apr-05 2-May-05 29-Jan-06 

13-Jan-06 29-Jan-06 1-Feb-07 

19-Apr-06 31-Dec-06 17-Feb-07 

16-Jan-07 1-Feb-07 7-Mar-08 

17-Feb-07 6-Apr-07 23-Mar-08 

8-May-07 19-Jan-08 6-Feb-09 

7-Mar-08 23-Mar-08 10-Mar-09 

8-Apr-08 24-Apr-08 25-Feb-10 

5-Jan-09 6-Feb-09 12-Feb-11 

10-Mar-09 26-Mar-09 28-Feb-11 

13-May-09 24-Jan-10 16-Mar-11 

25-Feb-10 14-Apr-10  

30-Apr-10 27-Jan-11  

12-Feb-11 28-Feb-11  

16-Mar-11 1-Apr-11  

17-Apr-11   
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and therefore contribute less often to the overall increases in the MTT values.  Furthermore, the 

intervals that remove the more recent rain events showed mediocre correlation with the strongest 

correlation occurring between 32-64d at 0.52.   

Restricting the correlation analyses to late-season dates has not only improved the correlation 

analysis, but may help explain the impacts of precipitation and temperature better than the complete 

dataset.  The dates used in the Combined Late Season Dates correlation analysis (Figure 14; blue 

squares) are documented in Table 4 and include dates from late January to late March for all seven 

seasons.  Similar to the complete dataset, the Late Season subset shows that the correlation between 

the MTT values and precipitation increases with longer timespans and peaks at the 96d time step with a 

correlation of 0.74.  The correlation for the Season interval (which measures precipitation between 112-

176d for these dates) decreases to 0.67.  The 96d interval totaling rain events for >5mm and >10mm 

also shows strong correlation at 0.77 and 0.62, correspondingly.  The Between Range correlation is the 

strongest at the 48-96d precipitation interval at 0.65.  It is evident by this result that the MTT values 

derived from the later ∆NDVI-S are often influenced by early season rainfall especially during drier 

winters.  Furthermore, for the Late Season subset, the correlation to mean temperature is positive for 

each of the 4 to 64d intervals then decreases to below zero at the 96d and Season interval.  Although 

not a strong correlation, this shows that mid-season cooler temperatures aid in plant growth at YPG 

during winter months.   

5.3 Combining Monsoon and Winter Seasons 

Antecedent precipitation inputs can play a major role in determining the immediate and long-lasting 

impacts to the vegetation of an area.  This may be especially true for dryland ecosystems.  Holmgren and 

Scheffer (2001) explain that increases in precipitation in southwestern deserts can initiate ecosystem 

state changes, generate growth of woody seedlings, and produce positive feedback loops that will 
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impact the ecosystem for years to come.  Moreover, Goodrich et al. (2008) measured a rise in winter 

precipitation during the last half of the twentieth century and attributed the increases in precipitation to 

a rise in ENSO conditions, while Kimball et al., (2010) suggests that a shift to later winter rains (from 

October to December) supports higher densities of winter annuals that take advantage of increased 

precipitation co-occurring with cooler temperatures.  

Figuƌe ϭϱ ĐoŵďiŶes the ΔNDVI-S of the moŶsooŶ seasoŶ ǁith the ΔNDVI-S winter seasons for years 

2004-05 to 2010-2011.  The 2004-05 winter season experienced extreme amounts of rainfall at YPG.  

From these rains, there was a noticeable increase in winter annuals during this season (Esque et al., 

2013) which can be attributed to the extreme increase of the MTT values seen in Figure 15; 04-05.  The 

 
 

Figure 15: This graph combines the changes in NDVI over the monsoon and winter seasons starting 

with June 2004 and going through June 2011.  The common scene used for each year (June to June) 

is the post-monsoon scene or base winter scene (larger symbols).  To reset every year, the base/pre-

monsoon scene for the 2004-05 dataset (July 2, 2004) was subtracted from the base/pre-monsoon 

season scene of each subsequent year.  Since July 2, 2004 is the earliest date used in this analysis, it 

is arbitrarily set at 0.  Each of the following years starts out as more positive (increase in plant 

biomass) than the July 2, 2004 Landsat scene.  

 



37 

 

pre-monsoon season Landsat scene (July 2, 2004), was subtracted from each of the following six years 

of pre-monsoon scenes, all of which documented a stronger NDVI signal at the start of each monsoon 

season than when compared to the 2004 scene.  The strongest increase in the MTT values for pre-

monsoon season imagery was seen immediately following the 2004-05 winter.  The following four 

winters had low to moderate winter precipitation and caused a decrease in the MTT values at the start 

of each monsoon season (2006-09).  However, 2009-10 was another notable winter for precipitation 

where the NCDC rain gauge 3125 measured at least 134mm of precipitation (data for December 2009 

were absent) with a single event measuring 60mm of rainfall.  The precipitation that occurred during 

2009-10 winter caused a gain in the MTT values at the start of the following (2010) monsoon season.  

5.4 Considerations 

Bƌooks et al. ;ϮϬϭϭͿ states that ͞tƌaŶslatiŶg ĐhaŶges iŶ pƌeĐipitatioŶ iŶto ĐhaŶges iŶ plaŶt aǀailaďle 

ǁateƌ is Ŷot stƌaightfoƌǁaƌd.͟  Similarly, using NDVI to investigate precipitation influences is not exact 

and there are a variety of factors that can either increase or decrease NDVI throughout the monsoon 

and winter seasons.  Such factors may include contributing area of the channel as well as channel type, 

size of the storm, storm intensity (higher overland flow with stronger intensities), type of riparian 

vegetation (woody versus herbaceous), vegetation densities or antecedent conditions.  Changes in 

landcover such as the decrease following the 2005 fire can also cause significant changes in NDVI that 

may misrepresent the true amount of precipitation, unless the disturbance is accounted for.  The timing 

of the remote sensing imagery can play a major role in indicating when and where flood events have 

occurred when using this method.  Landsat imagery has a 16 day temporal resolution and when cloud 

cover occurs within the imagery, then the temporal resolution can be pushed upwards of 32 or 48 days 

in between usable scenes.  Other remote sensing platforms may have shorter recurrence intervals, but 

these often suffer from coarser resolution or higher costs.  There are likely to be many other abiotic and 
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biotic variables that may influence the change in NDVI that are not mentioned here.  In spite of these 

limitations, the results of this study show that Landsat imagery can play a pivotal role in explaining the 

occurrence and magnitude of precipitation in dryland ecosystems.    

Most precipitation events are scarce and typically deliver less than a few millimeters of precipitation 

during each event.  Accurately mapping these rain events is difficult and errors are hard to detect.  

While radar data is spatially and temporally continuous, observed radar values often misrepresent the 

actual precipitation for a number of different reasons: including reflectance issues, obstructions such as 

mountain ranges, small spatial storms (resolution of NEXRAD data is 16km2), and overshooting the cloud 

layer as happens during low-top convection storms.  Moreover, from these data, it appears that NEXRAD 

is extremely inaccurate in measuring monsoon season precipitation and though it is more accurate for 

winter precipitation, it was shown here that NEXRAD typically underestimates precipitation at YPG and 

in surrounding areas. 
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CHAPTER 6: CONCLUSIONS 

 

 

 

This study proposes that the change in NDVI across ephemeral stream channels may be used as an 

alternative to historic rain gauge and radar precipitation data.  Landsat TM imagery has the spatial 

continuity that supersedes the densities of rain gauge sites and a historical record that far exceeds radar 

data.  The MTT values that are derived from the ΔNDVI-S along ephemeral stream channels provides a 

unique method for mapping the increases and decreases in plant biomass while indirectly mapping the 

spatial, temporal, and to some extent the quantity of precipitation in water-limiting systems.   

These data indicate that a strong increase in the MTT values between the pre- and post-monsoon 

season Landsat imagery reveal precipitation inputs and possibly the occurrence of flow events.  Analyses 

of two flow events indicates that increases of 0.0006 ∆NDVI/day or larger using the ∆NDVI-S MTT values 

over the course of the monsoon season suggests a flow event.  More comparisons may clarify the 

Ϭ.ϬϬϬϲ ∆NDVI/day threshold and may in fact reduce this value.  However, even without a true threshold, 

mapping the slope of the MTT values between the pre- and post-monsoon season scenes often shows 

strong increases in the MTT values beginning in upper stream channels and continuing downstream into 

braided channels, where the MTT values  lessen (Figure 12.A: Average Slope & Appendix E).  This reflects 

the fact that flow events are often localized in semi-arid systems. 

Combination of the monsoon and winter season MTT values for the overlapping years indicate that 

monsoon season precipitation may support vegetation into cooler winter months even when there is 

insignificant precipitation.  This analysis also indicates that for YPG, post-monsoon season imagery 

captured in early to mid-September is often too early to measure the true increases in the MTT values.  

A third conclusion that these data support is the influences of antecedent precipitation.  The above 
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average rainfall during the 2004-05 winter increased the MTT values for at least the subsequent four 

years until another rainy winter season ensued and caused another jump in the MTT values.   

The final conclusions from these data show that there is a moderate to high correlation between the 

MTT ǀalues deƌiǀed fƌoŵ the ǁiŶteƌ ∆NDVI-S and the NEXRAD precipitation data and that the strength 

of the correlation will vary considerably depending upon the weather for that year.  Combination of the 

seven winter seasons indicates that plant biomass will increase during the first 2-4 weeks following a 

rain event and continue to increase up to 2-3 months after the rain event(s).  The two time delay periods 

may reflect various types of vegetation in the region (i.e. shallow-rooted herbaceous or deep-rooted 

woody vegetation).  The occurrence of precipitation events 5mm or larger showed strong correlation to 

changes among MTT values and implies that a rain event measuring as little as 5mm should be 

considered a significant event to vegetation during winter months in semi-arid regions.  

The methodology and conclusions documented in this paper creates a novel method for measuring 

the spatial and temporal variability of precipitation in the Sonoran Desert by exploiting the strong 

connection between water inputs to vegetation growth, and finally, to the ability of remote sensing 

imagery to record such changes.  While there have been many other studies that have documented the 

relationship between precipitation and vegetation growth using NDVI, there have been far fewer that 

have used NDVI as a way to measure the spatial and temporal range of precipitation.  Even though this 

research attempts to find clear connections between precipitation and NDVI, the environment is vastly 

complex and such relationships are certainly contingent upon different circumstances. 
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CHAPTER 7: AFTERWORD 

 

 

 

In the fall of 2012, I entered graduate school but not as a full time student, instead as a guest 

student enrolled in two courses.  Although this was not my ideal situation, this allowed me to ease my 

way back into academia after a seven year break and build meaningful relationships with professors and 

students.  This also gave me the opportunity to become a NASA student intern with the NASA DEVELOP 

Program.  The NASA DEVELOP program is a 10-week paid internship that assembles a team of students 

to answer a preassigned ecological research question using remote sensing technology.  This internship 

with the two courses set me up for applying to a graduate student announcement working with the 

Strategic and Environmental Research and Development Program (SERDP) under Dr. Melinda Laituri that 

began the following semester.  This position allowed me to enroll in the Graduate Degree Program in 

Ecology (GDPE) and focused on using GIS and remote sensing technologies within ephemeral stream 

ecosystems in the arid southwest. 

I spent two years in this position and was extremely grateful to have it, however this does not come 

without hard work and challenging circumstances.  After I began the SERDP position in early 2013, the 

other CSU graduate student associated with this project resigned.  There were two other graduate 

students involved in the project, but they were based out of the University of Arizona in Tucson along 

with the principle investigator.  This made it hard to interact with them routinely and to develop a thesis 

where my skills and ideas would be most appropriate while aligning with my own interests. 

Although I had flexibility in selecting a research question, I experienced challenges many graduate 

students face with times of ambiguous direction while being conflicted by the need to complete what 

the resigned student had left, while trying to incorporate my own ideas.  A major challenge that I 

encountered was integrating myself into the SERDP RC-1727 project which was already halfway through 

its life span.  Field work was completed by the time I had arrived and funding and time were limited.  
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However, with the knowledge I gained from the NASA DEVELOP program, I began to see the potential 

for a thesis question while working with the GIS data at the DoD installations: Fort Bliss, Fort Huachuca, 

Yuma Proving Ground, and Fort Irwin.  This is when I developed the idea of linking vegetation to 

precipitation through remote sensing.  This is not a new topic and has been extensively study, however, 

I choose a new direction, suggesting that Landsat imagery can be a better data source when regarding 

Monsoon Season precipitation, something that RADAR and rain gauges often have a harder time 

measuring consistently.  This gave me a niche that I could pursue and most importantly, something that 

I found interesting.  

Unfortunately, as in most exploratory phases of research, it was difficult to really develop this idea 

and instead I pursued several other paths that eventually proved unsuccessful.  This ultimately slowed 

the completion of my thesis and defense considerably.  Throughout this process from the DEVELOP 

internship, to graduate assistantship, to developing my own thesis I have learned that determination 

and perseverance come from a passion for the subject.  I do not believe that without my genuine 

interest in these projects and my research topic that I would have completed this thesis.   

During the last phase of my graduate career (i.e. writing and defending my thesis), I took a position 

with the National Park Service at Colorado National Monument where I worked in removing invasive 

plant species and restoring native landscapes.  Though still a seasonal position, it is the very position 

that I went to graduate school for.  Working with the National Park Service has allowed me to work 

toward my career goal of managing and restoring native landscapes, but I was faced with the challenge 

of fiŶishiŶg gƌaduate sĐhool.  I do Ŷot ƌeĐoŵŵeŶd ǁoƌkiŶg ǁhile fiŶishiŶg a ŵasteƌ͛s degƌee, hoǁeǀeƌ iŶ 

my situation, it was the best thing I could do.  It was hard at times to stay on-track, but eventually I 

found the time and gained new perspectives on the demands of completing a research project.   

In the end, I am so very grateful for the graduate experience and the support provided by my 

advisor.  I learned a great deal in the classroom and even more crafting a valid research question with 
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the methods and statistics to support it.  This experience has also reinforced my interests in a career in 

land management.  I enjoy the knowledge that research brings and value their place in steering 

management practices and this experience has allowed me to develop useful and meaningful skills that I 

will be able to employ within a land management position.  Lastly, this assistantship has allowed me to 

develop my interpersonal skills by working toward project objectives.  This is a skill I did not have before 

staƌtiŶg this pƌojeĐt.  The ĐollaďoƌatioŶ aŶd ĐooƌdiŶatioŶ that ǁeƌe ŶeĐessaƌǇ foƌ the pƌojeĐt͛s suĐĐess 

have allowed me to see the utility in such an approach, while the independence has permitted me to 

bring my own skills and research questions to the table.  
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APPENDIX A: LIST OF DATA AND LANDSAT 5, 7, AND 8 SCENES USED 

 

 

 

 Table 5: Overview of data used in this study 

 

Data Type Resolution Objective USE Source 

LANDSAT 5 TM Grid 0.9 km2
 

Monsoon, 

Winter 

NDVI Response 

Variable 
http://glovis.usgs.gov/ 

LANDSAT 7 TM Grid 0.9 km2 Monsoon 
NDVI Response 

Variable 
http://glovis.usgs.gov/ 

LANDSAT 8 TM Grid 0.9 km2 Monsoon 
NDVI Response 

Variable 
http://glovis.usgs.gov/ 

NHDPlus V2 Vector Various 
Monsoon, 

Winter 

Input for the 

Inundated 1km 

Reach Polygons 

www.horizon-

systems.com/nhdplus/ 

National 

Elevation 

Dataset  

(1/3 arc second) 

Grid 10 m2 
Monsoon, 

Winter 

Input for the 

Inundated 1km 

Reach Polygons 

http://viewer.national

map.gov/viewer/ 

Inundated 1km 

Reach Polygons 
Vector Various 

Monsoon, 

Winter 

Riparian Area 

Polygons (RAPs): 

The unit of analysis 

data created for the 

SERDP: RC-1727 project 

Rain Gauge Vector ~1.5 km2 
Monsoon, 

Winter 
Assess Radar Data 

Data from the SERDP: 

RS-1725 project 

GHCN Rain 

Gauge Data  
Vector ~1.5 km2

 
Monsoon, 

Winter 

General Trends, 

Assess Radar Data 

http://www.ncdc.noaa.

gov/data-access/land-

based-station-

data/land-based-

datasets/global-

historical-climatology-

network-ghcn 

NEXRAD MPE Vector 16 km2 Winter 

Precipitation 

Estimates 

Jan 2005 – Apr 2011 

water.weather.gov/pre

cip/p_download _new/ 

PRISM 

Precipitation  
Grid 16 km2 Winter 

Precipitation 

Estimates Oct 2004 

–Dec 2004 

http://www.prism. 

oregonstate.edu/ 

PRISM 

Temperature 
Grid 16 km2 Winter 

Temperature 

Means 

October 2004 – 

April 2011 

http://www.prism. 

oregonstate.edu/ 
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   Table 6: An account of Landsat Scenes used in this study 
 

LANDSAT  ID 
Acquisition 

Date 

Radar Precipitation Data 

Interval 
Clouds 

# Days  

from base 

------- Monsoon Scene Dates ------- 

LT50380371986166XXX13 Jun 15, 1986 NA None Base 

LT50380371986294XXX03 Oct 21, 1986 NA None 128 

LT50380371987169XXX07 Jun 18, 1987 NA None Base 

LT50380371987281XXX01 Oct 8, 1987 NA None 112 

LT50380371988156XXX07 Jun 4, 1988 NA None Base 

LT50380371988268XXX03 Sep 24, 1988 NA None 112 

LT50380371989174XXX02 Jun 23, 1989 NA None Base 

LT50380371989270XXX02 Sep 27, 1989 NA None 96 

LT50380371990145AAA03 May 25, 1990 NA None Base 

LT50380371990273XXX02 Sep 30, 1990 NA None 128 

LT50380371991180XXX03 Jun 29, 1991 NA None Base 

LT50380371991276XXX02 Oct 3, 1991 NA None 96 

LT50380371992167XXX03 Jun 15, 1992 NA None Base 

LT50380371992279AAA02 Oct 5, 1992 NA None 112 

LT50380371993185XXX02 Jul 4, 1993 NA None Base 

LT50380371993281AAA04 Oct 8, 1993 NA None 96 

LT50380371994188XXX02 Jul 7, 1994 NA None Base 

LT50380371994284AAA02 Oct 11, 1994 NA None 96 

LT50380371995159XXX02 Jun 8, 1995 NA None Base 

LT50380371995255XXX02 Sep 12, 1995 NA None 96 

LT50380371996130XXX02 May 9, 1996 NA None Base 

LT50380371996290XXX01 Oct 16, 1996 NA None 160 

LT50380371997196XXX02 Jul 15, 1997 NA None Base 

LT50380371997292XXX02 Oct 19, 1997 NA None 96 

LT50380371998167XXX02 Jun 16, 1998 NA None Base 

LT50380371998279XXX02 Oct 6, 1998 NA None 112 

LT50380371999154XXX05 Jun 3, 1999 NA None Base 

LT50380371999250XXX04 Sep 7, 1999 NA None 96 

LE70380372000165EDC00 Jun 13, 2000 NA None Base 

LE70380372000261EDC00 Sep 17, 2000 NA None 96 

LE70380372001167EDC00 Jun 16, 2001 NA None Base 

LE70380372001263EDC00 Sep 20, 2001 NA None 96 

LE70380372002170EDC00 Jun 19, 2002 NA None Base 

LE70380372002266EDC00 Sep 23, 2002 NA None 96 

LT50380372003165LGS01 Jun 14, 2003 NA None Base 

LT50380372003261PAC02 Sep 18, 2003 NA None 96 

LT50380372004184PAC01 Jul 2, 2004 NA None Base 

LT50380372004280PAC01 Oct 6, 2004 NA None 96 

LT50380372005170PAC01 Jun 19, 2005 NA None Base 

LT50380372005250PAC01 Sep 7, 2005 NA None 80 
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LT50380372005282PAC01 Oct 9, 2005 NA None 112 

LT50380372006173PAC02 Jun 22, 2006 NA None Base 

LT50380372006269PAC01 Sep 26, 2006 NA None 96 

LT50380372007176PAC01 Jun 25, 2007 NA None Base 

LT50380372007272EDC00 Sep 29, 2007 NA None 96 

LT50380372008163PAC02 Jun 11, 2008 NA None Base 

LT50380372008275PAC01 Oct 1, 2008 NA None 112 

LT50380372009181PAC01 Jun 30, 2009 NA None Base 

LT50380372009293PAC01 Oct 20, 2009 NA None 112 

LT50380372010184EDC00 Jul 3, 2010 NA None Base 

LT50380372010248PAC01 Sep 5, 2010 NA None 64 

LT50380372011171PAC01 Jun 20, 2011 NA None Base 

LT50380372011251PAC02 Sep 8, 2011 NA None 80 

------- Monsoon Flood Events Scene Dates ------- 

LT50380371989174XXX02 Jun 23, 1989 NA None Base 

LT50380371989206XXX02 Jul 25, 1989 NA None 32 

LT50380371989238XXX02 Aug 26, 1989 NA None 64 

LT50380371989254XXX02 Sep 11, 1989 NA None 80 

LT50380371989270XXX02 Sep 27, 1989 NA Some 96 

LT50380371989302XXX02 Oct 29, 1989 NA None 128 

LC80380372013208LGN00 Jul 27, 2013 NA None Base 

LC80380372013224LGN00 Aug 12, 2013 NA None 16 

LC80380372013256LGN00 Sep 13, 2013 NA None 48 

LC80380372013288LGN00 Oct 15, 2013 NA None 80 

LC80380372013304LGN00 Oct 31, 2013 NA None 96 

------- Winter Scene Dates ------- 

2004-2005:  Total Precip (Oct 1 – Mar 31): 102.8mm  (Virtual Grid: 269218) 

LT50380372004280PAC01 Oct 6, 2004 2004 Base None 0 

LT50380372004296PAC01 Oct 22, 2004 4, 8, 16, Season Some 16 

LT50380372004328PAC01 Nov 23, 2004 4, 8, 16, 32, 48, Season None 48 

LT50380372004344PAC02 Dec 9, 2004 4, 8, 16, 32, 48, 64, Season None 64 

LT50380372004360PAC01 Dec 25, 2004 4, 8, 16, 32, 48, 64, Season None 80 

LT50380372005058PAC01 Feb 27, 2005 4, 8, 16, 32, 48, 64, 96, Season Some 144 

LT50380372005074PAC01 Mar 15, 2005 4, 8, 16, 32, 48, 64, 96, Season None 160 

LT50380372005090PAC01 Mar 31, 2005 4, 8, 16, 32, 48, 64, 96, Season None 176 

LT50380372005106PAC01 Apr 16, 2005 4, 8, 16, 32, 48, 64, 96, Season None 192 

LT50380372005138PAC01 May 18, 2005 NA None 224 

LT50380372005170PAC01 Jun 19, 2005 NA – Monsoon Base None 256 

2005-2006:  Total Precip (Oct 1 – Mar 31): 27.7mm  (Virtual Grid: 269218) 

LT50380372005282PAC01 Oct 9, 2005 2005 Base None 0 

LT50380372005330PAC01 Nov 26, 2005 4, 8, 16, 32, 48, Season None 48 

LT50380372006013EDC00 Jan 13, 2006 4, 8, 16, 32, 48, 64, 96, 

Season 

None 96 

LT50380372006029PAC01 Jan 29, 2006 4, 8, 16, 32, 48, 64, 96, Season None 112 
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LT50380372006093PAC01 Apr 3, 2006 4, 8, 16, 32, 48, 64, 96, Season Some 176 

LT50380372006109PAC01 Apr 19, 2006 4, 8, 16, 32, 48, 64, 96, Season None 192 

LT50380372006141PAC01 May 21, 2006 NA  None 224 

LT50380372006173PAC02 Jun 22, 2006 NA – Monsoon Base None 256 

2006-2007:  Total Precip (Oct 1 – Mar 31): 19.8mm  (Virtual Grid: 269218) 

LT50380372006269PAC01 Sep 26, 2006 2006 Base None 0 

LT50380372006285PAC01 Oct 12, 2006 4, 8, 16, Season None 16 

LT50380372006301PAC01 Oct 28, 2006 4, 8, 16, 32, Season None 32 

LT50380372006333PAC01 Nov 29, 2006 4, 8, 16, 32, 48, 64 Season None 64 

LT50380372006365PAC01 Dec 31, 2006 4, 8, 16, 32, 48, 64, 96, Season None 96 

LT50380372007016PAC01 Jan 16, 2007 4, 8, 16, 32, 48, 64, 96, Season None 112 

LT50380372007032PAC01 Feb 1, 2007 4, 8, 16, 32, 48, 64, 96, Season None 128 

LT50380372007048PAC01 Feb 17, 2007 4, 8, 16, 32, 48, 64, 96, Season None 144 

LT50380372007096PAC01 Apr 6, 2007 4, 8, 16, 32, 48, 64, 96, Season Some 192 

LT50380372007128PAC01 May 8, 2007 NA None 224 

LT50380372007160PAC01 Jun, 9, 2007 NA None 256 

LT50380372007176PAC01 Jun 25, 2007 NA – Monsoon Base None 272 

LEAPYEAR.  2007-2008:  Total Precip (Oct 1 – Mar 31): 47.8 mm  (Virtual Grid: 269218) 

LT50380372007272EDC00 Sep 29, 2007 2007 Base None 0 

LT50380372008019EDC00 Jan 19, 2008 4, 8, 16, 32, 48, 64, 96, Season None 112 

LT50380372008067PAC01 Mar 7, 2008 4, 8, 16, 32, 48, 64, 96, Season Some 160 

LT50380372008083PAC01 Mar 23, 2008 4, 8, 16, 32, 48, 64, 96, Season None 176 

LT50380372008099PAC01 Apr 8, 2008 4, 8, 16, 32, 48, 64, 96, Season None 192 

LT50380372008115PAC01 Apr 24, 2008 4, 8, 16, 32, 48, 64, 96, Season None 208 

LT50380372008147PAC01 May 26, 2008 NA None 240 

LT50380372008163PAC02 Jun 11, 2008 NA – Monsoon Base None 256 

2008-2009:  Total Precip (Oct 1 – Mar 31): 31.2 mm  (Virtual Grid: 269218) 

LT50380372008275PAC01 Oct 1, 2008 2008 Base None 0 

LT50380372008291PAC01 Oct 17, 2008 4, 8, 16, Season None 16 

LT50380372008323PAC01 Nov 18, 2008 4, 8, 16, 32, Season None 48 

LT50380372009005PAC01 Jan 5, 2009 4, 8, 16, 32, 48, 64, Season None 96 

LT50380372009037PAC01 Feb 6, 2009 4, 8, 16, 32, 48, 64, 96, Season Some 128 

LT50380372009069PAC01 Mar 10, 2009 4, 8, 16, 32, 48, 64, 96, Season None 160 

LT50380372009085PAC01 Mar 26, 2009 4, 8, 16, 32, 48, 64, 96, Season None 176 

LT50380372009133PAC01 May 13, 2009 NA None 224 

LT50380372009181PAC01 Jun 30, 2009 NA – Monsoon Base None 272 

2009-2010:  Total Precip (Oct 1 – Mar 31): 95.3mm  (Virtual Grid: 269218) 

LT50380372009293PAC01 Oct 20, 2009 2009 Base None 0 

LT50380372009309PAC01 Nov 5, 2009 4, 8, 16, Season None 16 

LT50380372009325PAC01 Nov 21, 2009 4, 8, 16, 32, Season None 32 

LT50380372010024PAC01 Jan 24, 2010 4, 8, 16, 32, 48, 64, Season None 64 

LT50380372010056PAC01 Feb 25, 2010 4, 8, 16, 32, 48, 64, 96, Season None 160 

LT50380372010104PAC02 Apr 14, 2010 4, 8, 16, 32, 48, 64, 96, Season None 208 

LT50380372010120PAC01 Apr 30, 2010 4, 8, 16, 32, 48, 64, 96, Season Some 224 

LT50380372010136PAC01 May 16, 2010 NA None 240 

LT50380372010168EDC00 Jun 17, 2010 NA None 272 
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LT50380372010184EDC00 Jul 3, 2010 NA – Monsoon Base None 288 

2010-2011:  Total Precip (Oct 1 – Mar 31): 39.9mm  (Virtual Grid: 269218) 

LT50380372010248PAC01 Sep 5, 2010 2010 Base None 0 

LT50380372010280PAC01 Oct 7, 2010 4, 8, 16, 32, Season Some 32 

LT50380372010344EDC00 Dec 10, 2010 4, 8, 16, 32, 48, 64, 96, Season None 96 

LT50380372011027EDC00 Jan 27, 2011 4, 8, 16, 32, 48, 64, 96, Season None 144 

LT50380372011043PAC01 Feb 12, 2011 4, 8, 16, 32, 48, 64, 96, Season None 160 

LT50380372011059PAC01 Feb 28, 2011 4, 8, 16, 32, 48, 64, 96, Season None 176 

LT50380372011075EDC00 Mar 16, 2011 4, 8, 16, 32, 48, 64, 96, Season None 192 

LT50380372011091PAC01 Apr 1, 2011 4, 8, 16, 32, 48, 64, 96, Season None 208 

LT50380372011107PAC01 Apr 17, 2011 4, 8, 16, 32, 48, 64, 96, Season None 224 

LT50380372011123PAC01 May 3, 2011 NA None 240 

LT50380372011155PAC01 Jun 4, 2011 NA None 272 

LT50380372011171PAC01 Jun 20, 2011 NA – Monsoon Base None 288 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



53 

 

APPENDIX B: METHODS 

 

 

 

The following section expands upon the Methods section described in the main document and 

reflects the workflow shown in Figure 3.  For a list of all data used in these analyses, refer to Appendix A: 

Tables 5 & 6.  The mean NDVI value of the top ten percent (MTT) along each riparian area polygon (RAP) 

were calculated along the subtracted NDVI Landsat sĐeŶes ;ΔNDVI-S) for both monsoon and winter 

dates.  Coefficient of variation (CV) was used to determine the spatial uniformity and temporal 

variability of the changes in monsoon season NDVI over the 26 year study period.  Correlation analysis 

were used to relate precipitation derived from radar instruments to increases in NDVI over the course of 

the winter rainy season.  A final analysis was created that combined the monsoon and winter season 

analyses.   

Riparian Area Polygons (RAPs) 

Stream reaches were created for the SERDP RC-1727 funded project (Levick et al., 2015).  They were 

originally derived from the NHDPlus Version 2 (V2) dataset downloaded from the Horizon Systems 

website (www.horizon-systems.com/nhdplus/) for the Lower Colorado (Vector Processing Unit 15).  

Using ArcMap 10.2, the NHDPlus V2 flowline layer was split into 2,843 reaches at approximately 1km in 

  

Figure 16:  Representation of the 3m inundated Riparian Area Polygons (RAPs). 

 

http://www.horizon-systems.com/nhdplus/
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length.  To achieve the riparian area along each reach, the 2,843 reach layer was buffered to 200m on 

either side of the flowline.  The unbroken flowline layer was inundated to 3m using the HGVC (Hydro-

Geomorphic Valley Classification) extension tool (Carlson E.A., 2009) with a 10m DEM in ArcMap 10.2.  

The 200m buffered reach layer was clipped back to the 3m inundated layer.  Nearby reaches and areas 

of confluences had to be manually edited to remove the excess areas.  This new layer was used to 

represent the riparian areas along the NHDPlus V2 flowline layer and was used as the spatial unit in this 

analysis (RAP; Figure 16). 

Landsat TM Imagery 

Landsat 5 Thematic Mapper (TM) has been an exceedingly useful tool as it provided imagery at 16 

day intervals and in 7 wavelengths for nearly 27 years that was decommissioned in November of 2011.  

Landsat 5 TM is free to the public and has a pixel resolution of 30m2.  Landsat 7 TM is the next 

generation and was launched in 1999.  Landsat 7 TM is very comparable to Landsat 5 TM.  From 1999 to 

2003, it successfully collected images until the Scan Line Corrector instrument failed in May of 2003.  

Scenes from years 2000 to 2002 were incorporated into this analysis to replace inadequate Landsat 5 

TM images.  Scenes from Landsat 5 & 7 TM: Path 38, Row 37 were downloaded via GlobeVis 

(http://glovis.usgs.gov/) for pre- and post-monsoon season and winter dates.  Acquisition dates for each 

analysis are shown in Figure 17 and 18. 

Many useful indices have been developed from the bands associated with Landsat satellites; 

however, NDVI has proven to be a valuable and simple index that has been used in combination with 

many ecological and remote sensing inquires.  NDVI takes advantage of the chlorophyllic processes by 

combining the Red and NIR bands where plant material reflects the NIR wavelengths while the red 

wavelengths are absorbed by chlorophyll (Nicholson & Farrar, 1994; Pettorelli et al., 2005; Brown et al., 

2006).  The difference between these two wavelengths divided by the sum calculates the NDVI value 

http://glovis.usgs.gov/
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Figure 17:  Pre- and post-monsoon season Landsat image selection.  All scenes were captured from 

the Landsat 5 TM satellite platform except from 2000 to 2002 that were captured from Landsat 7 TM. 

Figure 18:  Frequency and distribution of Landsat 5 TM dates for the winter NDVI analysis.  Base 

dates are shown as #1.  Because Landsat 5 TM has a 16d temporal resolution, these dates are in 

16d intervals or a multiple of 16.  Skipped days are the result of heavy cloud cover.  Low cloud 

cover dates were included. 
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and has been shown to map vegetation via chlorophyllic content around the globe (Pettorelli et al., 

2005; Brown et al., 2006).  Other vegetation indices exist and have been used in replacement of NDVI, 

such as MSAVI and MSAVI2 (Qi et al., 1994).  Since this research is looking at change detection instead of 

vegetation classification, NDVI is used instead of MSAVI2 which takes into account regions of bare soil 

and has a more complicated equation.  

All Landsat images were processed in ENVI 5.0 (Radiometric Calibration for Reflectance and Dark 

Object Subtraction were applied to all scenes).  Each image was then uploaded in ARCMap 10.2.  All 

monsoon season scenes chosen lacked clouds.  The post-monsoon season scene served as the base 

winter scene for winters beginning in 2004 through 2010.  When clouds were present in the subsequent 

winter scenes, these areas were removed.  The following steps were applied to each scene in this order 

and the resulting monsoon ΔNDVI-S͛s are shown in Figure 7 (the wiŶteƌ ΔNDVI-S are not shown here). 

1) NDVI Calculation 

A Model Builder tool was created using Raster Calculator Tool with the following equation: 

("%NIR Band%" - "%Red Band%") / ("%NIR Band%" + "%Red Band%") 

2) Extraction of Study Area and Reduction of Cell Size  

Each scene was reduced to the study area using the Extract by Mask tool with a constant 

boundary layer.  The cell size of each pixel was reduced to 5m before running the tool 

using a common NDVI image so that each cell lined up properly (Environment tab: Raster 

Analysis: Cell Size = 5; this step does not modify any of the NDVI values).  If clouds were 

present, the regions were masked out.  

3) Change in NDVI SĐene (ΔNDVI-S) 

The later scene was subtracted from the base scene using the Raster Calculator tool 

(Post-Monsoon – Pre-Monsoon or Later Winter Date – Base Winter Date). 
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4) Extract the values of ΔNDVI-S to RAPs 

Each ΔNDVI-S was reduced to every RAP using the Extract by Mask tool then converted 

into an ASCII text file by using the Raster to Ascii tool (A model builder tool was created 

to iterate through the 2,843 RAPs). 

5) Calculate the mean value of the Change in NDVI for the Top Ten Percent of the pixels within 

each RAP (MTT value per RAP per ΔNDVI-S) 

A Python Script was created (by Eric Schmidt) to extract all values of each RAP ASCII 

teǆt file foƌ eaĐh ΔNDVI-S and subset the top 10% (rounding down; MTT).  The mean 

value was calculated off this subset and aggregated into a single CSV file for each 

ΔNDVI-S (Figure 19). The code used is as follows: 

 

import os 

import numpy as np 

 

folder = "select local folder Path" 

value_stuff = {} 

 

for path,dir,files in os.walk(folder):  

    output_file = os.path.join(path, 'MTT_values.csv')  

    with open(output_file, 'wb') as out_file: 

        out_file.write('Rast_ID, TopTenMEAN {}'.format(os.linesep)) 

        for file in files:   

            if file.endswith('.txt'):   

                full_file = os.path.join(path, file) 

                print full_file 

                data_values = [] 

                with open(os.path.join(path,file), 'rb') as data_file: 

                    for j,line in enumerate(data_file): 

                        if j > 5: 

                            my_vals = line.split()  

                            data_values.extend([float(item) for item in my_vals if float(item) != -9999.0]) 

                data_values.sort() 

                num_values = len(data_values) 

                ix_top_values = int(np.floor(num_values*.9)) 

                print ix_top_values 

                top_values = data_values[ix_top_values:] 

                mean_value = np.mean(top_values) 

                value_stuff[full_file] = mean_value 

                print '{} file has mean {}'.format(full_file, mean_value) 

 

                out_file.write('{},{}{}'.format(file.split('.')[0], mean_value, os.linesep)) 
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NEXRAD Data (Winter only) 

In an effort to reduce the amount of data, the version of the NEXRAD virtual grid layer that was 

created by Russell Lyon (Lyon R., 2013) for YPG was used where nine NEXRAD virtual rain gauge grids 

were averaged together creating a mean precipitation value for each day that spanned over the 144km2 

grid.  Although this is a considerably large area, when considering the storm type (i.e. large frontal 

storms), this area is reasonable.  This created a total of 60 grids that covered the study area.  These grid 

layers were linked to the reaches at YPG using the Spatial Join tool in ARCMap 10.2.  This allowed each 

reach to be connected to the daily NEXRAD and PRISM precipitation data. 

Daily precipitation estimates of NEXRAD data were tabulated using Microsoft Excel.  For each 

Landsat scene (excluding the Base scene), the sum of precipitation for the previous time periods at the 

4, 8, 16, 32, 48, 64, 96 day and Seasonal time steps were calculated for each year.  Earlier winter scenes 

A B 

Figure 19: These figures demonstrate the methods for extracting the MTT NDVI values within each 

reach.  For each ∆NDVI-S, each RAP was extracted separately by using individual RAP shapefiles in 

ArcMap 10.2 (shown in Figure A), then converted into an ASCIIi text file that contains every pixel 

value within the RAP.  The values of the pixels representing the Top 10% are depicted in Figure B.  

These values were extracted from the ascii text file using the python code and the MTT was 

ĐalĐulated.  This ǁas doŶe foƌ eǀeƌǇ ∆NDVI-S at every RAP unit.   
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had null values in the longer time steps when the time step went earlier than the base image.  

Additional parameters were calculated describing the amount of rain events of >5mm and >10mm that 

occurred in the 32, 48, and 96d time steps.  Precipitation was also totaled between ranges 8-16d, 16-

32d, 16-48d, 32-64d, and 48-96d before each scene. 

PRISM Mean Temperature Data (Winter only) 

Temperature data were also downloaded through the PRISM Climate Group (http://www.prism. 

oregonstate.edu/).  This research used daily mean temperature that were downloaded as ASCII files in 

units of degrees Celsius with a spatial resolution of 4km2.  The temperatures for each day during the 

study period were averaged over the 60 NEXRAD grids at 12km2 resolution.  The daily mean 

temperature values for each winter season were tabulated.  Microsoft Excel was used to calculate the 

mean temperature values at the 4, 8, 16, 32, 48, 64, 96 day and Seasonal time steps previous to each 

Landsat image.  Earlier winter scenes had null values in the longer time steps.   
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Combining NEXRAD, PRISM, and Landsat 5 TM Data (Winter only) 

The aforementioned data was combined into a table for each winter season.  This was done by 

creating two unique identifiers where the RAP identifier and the Gauge identifier were linked to the date 

of each winter Landsat scene (Base scene excluded).  RAPs and Gauge identifiers were repeated to fulfill 

every winter Landsat date.  All data were now joined together between the two unique identifiers and 

organized into a single database table per winter season with the following column headers: 

Date:  Landsat scene date (more recent date) 

UniqID:  Modified UniqueID containing the Landsat scene date. 

GaugeUniqID:  Modified GaugeID containing the Landsat scene date 

UniqueID:  Original SERDP RC-1727 Unique Identifier 

GaugeID:  Unique Identifier for the NEXRAD grid layer combining 9 grids into one 12x12km grid (n=60) 

MTT:  Mean NDVI of the Top 10% (MTT) between the Landsat sĐeŶe aŶd the ďase sĐeŶe ;∆NDVI-S) 

Precip4d:  Previous 4 day precipitation totals from Landsat scene 

Precip8d:  Previous 8 day precipitation totals from Landsat scene 

Precip16d:  Previous 16 day precipitation totals from Landsat scene 

Precip32d:  Previous 32 day precipitation totals from Landsat scene 

Precip48d:  Previous 48 day precipitation totals from Landsat scene 

Precip64d:  Previous 64 day precipitation totals from Landsat scene 

Precip96d:  Previous 96 day precipitation totals from Landsat scene 

PrecipSeason:  Precipitation totals between Landsat scene and the Base scene 

Temp4d:  Previous 4 day temperature means from Landsat scene 

Temp8d:  Previous 8 day temperature means from Landsat scene 

Temp16d:  Previous 16 day temperature means from Landsat scene 

Temp32d:  Previous 32 day temperature means from Landsat scene 

Temp48d:  Previous 48 day temperature means from Landsat scene 

Temp64d:  Previous 64 day temperature means from Landsat scene 

Temp96d:  Previous 96 day temperature means from Landsat scene 

TempSeason:  Temperature means between Landsat scene and the Base scene 

Days5mm32d: Number of the previous 32 days where precipitation sums were 5mm or greater 

Days5mm48d: Number of the previous 48 days where precipitation sums were 5mm or greater 

Days5mm96d: Number of the previous 96 days where precipitation sums were 5mm or greater 

Days10mm32d: Number of the previous 32 days where precipitation sums were 10mm or greater 

Days10mm48d: Number of the previous 48 days where precipitation sums were 10mm or greater 

Days10mm96d: Number of the previous 96 days where precipitation sums were 10mm or greater 

Range8-16d: Total precipitation between 8 and 16 days prior to the Landsat scene 

Range16-32d: Total precipitation between 16 and 32 days prior to the Landsat scene  

Range16-48d: Total precipitation between 16 and 48 days prior to the Landsat scene 

Range32-64d: Total precipitation between 32 and 64 days prior to the Landsat scene 

Range48-96d: Total precipitation between 48 and 96 days prior to the Landsat scene 
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APPENDIX C: INSTRUMENT COMPARISON AND LINEAR REGRESSIONS 

 

 

 

Precipitation Data and Preparation for Instrument Comparison 

The first task of this research was to acquire the Rain Gauge, NEXRAD and PRISM data from the 

appropriate sources.  Appendix A: Table 5 documents the data type, resolution, its use, and the source 

of each dataset.  After the data were acquired the precipitation estimates were compared using Linear 

Regression for multiple years and divided between the two rainy seasons (monsoon and winter).  This 

step was necessary to field check the radar data against the rain gauge sites within the YPG vicinity and 

determine if or when the radar data can be used as a surrogate dataset to the rain gauge data in order 

to estimate the spatial and temporal variability of vegetation response to precipitation in semi-arid 

landscapes.  RStudio 3.1.1 (R Core Team, 2014) was used to run all statistical analysis.  

Rain Gauge Data 

Rain gauge data exists for YPG in two separate washes from the SERDP: RS-1725 funded research 

and from the GHCN dataset (Figure 20).  Yuma Wash (Figure 21) is located in the south western portion 

of the installation and had five separate rain gauge sites; though only three gauges were used in this 

study and were between 2 and 3.5km away from each other.  Mohave Wash is located in the north 

western portion of the installation and had a total of four rain gauge stations, although only two were 

used in this analyses: MBA and MBD (Figure 24).  All rain gauge sites were activated in 2011 and 

decommissioned in late spring of 2014.  Each site measured precipitation with a TE 525 Tipping Bucket 

rain gauge system at 0.254mm per tip rate.  The Yuma and Mohave wash rain gauge sites were in 

working order for most of the period, but contain scattered periods of disuse. 
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NEXRAD Data   

NEXRAD data are a type of Doppler radar that can measure precipitation amounts from fixed 

stations that are located throughout the US and estimates precipitation up to a distance of 230km away  

Figure 20: Historic monsoon precipitation at YPG.  Yuma data acquired through the National Weather 

Service Forecast Center (http://www.wrh.noaa.gov/twc/monsoon/monsoon_yum.php); GHCN data 

acquired though the NOAA National Climatic Data Center (http://www.ncdc.noaa.gov/data-

access/land-based-station-data). 

 

http://www.wrh.noaa.gov/twc/monsoon/monsoon_yum.php
http://www.ncdc.noaa.gov/data-access/land-based-station-data
http://www.ncdc.noaa.gov/data-access/land-based-station-data
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(Fulton, 2002).  Radar emits a signal that increases in altitude as you move further from the station and 

samples higher altitudes that do not necessarily represent what is occurring on the surface.  At mid to 

far ranges (100km and beyond), NEXRAD stations may actually measure more rainfall than is present 

aŶd theƌefoƌe haǀe a teŶdeŶĐǇ to Đƌeate a ͚ƌaŶge-ƌelated ďias͛ ;FultoŶ, ϮϬϬϮͿ.  Pƌeǀious ǀeƌsioŶs of 

NEXRAD (Stage II & III) data led to the creation of the Multisensor Precipitation Estimator (MPE) that 

combines Stage II data and independent rain gauge data with satellite precipitation data (GOES Satellite 

imagery) to produce more accurate precipitation estimates by minimizing local bias errors and 

enhancing coverage thru decreasing beam blockage and reducing spatial uniformity with rain gauge data 

(Fulton, 2002).  Mountain Mapper is similar to MPE, but is used in areas that are affected by orographic 

Figure 21: Location of Rain Gauge sites at Mohave and Yuma Wash. 

Yuma Wash 
Mohave Wash 

Yuma Wash 
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precipitation, commonly in the western US during winter seasonal precipitation (Schaake et al., 2004).  

NEXRAD MPE and Mountain Mapper products are processed through the National Weather Service: 

River Forecast Centers since 2004.  The precipitation data are delivered in a 16km2 resolution in inches 

and are combined to create the Stage IV NEXRAD product for the Contiguous US.   

The NEXRAD station YUX covers most of YPG and resides southwest of the boundary (Figure 22).  

The rain gauge sites for Yuma Wash were located in the Best Radar Coverage area (where the radar 

station is able to capture weather as low as 4,000ft) and were approximately 80km away, while Mohave 

Wash rain gauge sites were located in the Better Radar Coverage area (where the radar station is able to 

capture weather not lower than 6,000ft) and were around 125km away.  The NEXRAD data were 

downloaded from the National Weather Service website (water.weather.gov/precip/p_download_new) 

Figure 22: Left: NEXRAD extent and coverage variability.  Right: Location of rain gauge sites.  The blue 

sites (Yuma Wash) fall within the Best Radar Coverage Band (Coverage at 4,000ft and above the 

ground) and the red sites (Mohave Wash) are on the edge of the green and yellow band (between 

4,000ft and 6,000ft above the ground).  Left image source: 

http://gis.ncdc.noaa.gov/map/viewer/#app=cdo&cfg= radar&theme=radar&display=nexrad 

http://gis.ncdc.noaa.gov/map/viewer/#app=cdo&cfg= radar&theme=radar&display=nexrad
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by using a python script created by Mehmet Ercan (http://mehmetbercan.com/scripts/scriptsGIS.html) 

that downloads and clips the NEXRAD data after January 2, 2005 in ArcMap 10.2.  It was further 

processed into tabular format of daily precipitation totals per each virtual grid point in mm.  These data 

were compared to the PRISM data and the acquired Rain Gauge data for the closest NEXRAD virtual rain 

gauge daily precipitation values. 

PRISM Data 

Since the NEXRAD data that were used started on January 2, 2005, during a particularly wet winter 

season, PRISM data were used to estimate the rainfall previous to January 2, 2005 for that season.  The 

PRISM data were also compared to the 2011-2014 rain gauge data to compare all datasets.  PRISM data 

were downloaded through the PRISM CLIMATE GROUP (http://www.prism.oregonstate.edu/) and came 

in daily ASCII files for the contiguous United States.  The resolution is the same as NEXRAD data at 16km2 

and are in units of mm.   

Inverse Distance Weighting  

The Inverse Distance Weighting method was applied separately to each of the rain gauge sites and 

the associated NEXRAD/PRISM grid cell centers in order to assign a distance weighted precipitation 

estimate for the radar data at each rain gauge location.  The equation used to assign these weights is 

shown in Equation 1; where wi is the weight of the radar grid cell depending on the distance to the rain 

gauge site, n is the total number of grids that were used to determine the precipitation, and di is the 

distance between the grid center point and the rain gauge: 

Equation 1:                       �� = ଵ ௗ�⁄∑ ଵ ௗ�⁄��=భ  

 

http://mehmetbercan.com/scripts/scriptsGIS.html
http://www.prism.oregonstate.edu/
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Radar precipitation estimates at the rain gauge location were determined for each day using the 

following equation where Pe = precipitation estimate, n = total grid cells used, pi = precipitation at that 

grid cell and wi is the weight that is assigned to each grid in Equation 1: 

 

Equation 2:                        �௘ = ∑ ����௡�=ଵ  

 

 

 

 

Precipitation Instrument Comparative Analysis 

Several linear regression models were conducted in RStudio (R Core Team, 2014) to investigate the 

statistical difference between the rain gauge sites in Yuma and Mohave Wash at YPG.  The adjusted R2 

values and slopes are included below.  When the adjusted R2 values approach 1, then the two different 

data sources indicate synchronism.  When the slope is near 1 then the data sources can be said to show 

similar rainfall totals.  When the rain gauge and the NEXRAD precipitation data show these trends, then 

the radar data may be considered a reliable surrogate for rain gauge data. 

NEXRAD and PRISM Comparison 

Even though NEXRAD and PRISM 

data are on similar scales, there still 

are some discrepancies.  By 

comparing the NEXRAD and PRISM 

data at one virtual rain gauge site in 

Yuma Wash over 9 years, I found the 

data correlates 64% of the time 

(Average Adj R2, Table 7).  Neither 

Table 7: NEXRAD - PRISM comparison considering 9 

consecutive years of precipitation data.  Here, the NEXRAD 

data were plotted on the Y-axis and the PRISM on the X-axis, 

thus slopes less than 1 suggest that the PRISM dataset is 

measuring more precipitation than the NEXRAD data and 

vice versa for slopes greater than 1. 

Year Slope Adj R2 Year Slope Adj R2 

2005 0.67 0.42 2010 1.05 0.86 

2006 0.80 0.30 2011 0.87 0.46 

2007 1.90 0.94 2012 1.24 0.77 

2008 0.92 0.47 
2013 

(Jan – Aug) 
0.88 0.80 

2009 1.96 0.77 Average 1.00 0.64 
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the NEXRAD nor the PRISM data are considered to be ground truth, so this analysis is merely a 

comparison between these data sources.   

Rain Gauge to Radar Comparison: Yuma Wash  

When comparing the data for Yuma Wash rain gauge sites to the NEXRAD radar data, many of the 

rain events were off by one day and produce poor correlation results.  The Linear Regression results that 

are shown in Tables 8 & 9 and Figures 23 & 24 used data that I have altered to combine consecutive day 

rain events - meaning that the NEXRAD data were typically moved to the day before or at times, when 

the NEXRAD data documented consecutive day rain events, the precipitation amounts were totaled into 

single day events.  This is acceptable because the NEXRAD data uses Greenwich Mean Time for the start 

and end of a day, therefore any precipitation events that occurred after 6 pm at YPG were recorded the 

day after. 

The rain gauge and the radar 

data were compared in two 

different ways using linear 

regressions.  The first analyses 

included precipitation data from 

the entire year (Table 8) and 

received poor adjusted R2 results 

(mean NEXRAD: 0.18 and mean 

PRISM: 0.21).  The second analysis 

excluded the summer months that are affected by monsoon storms (May 1 to September 30), therefore 

only examining winter frontal storms (Table 9 & Figure 23).  The NEXRAD vs rain gauge comparison using 

winter precipitation data received the greatest adjusted R2 value (0.81) thus suggesting that NEXRAD 

Table 8: Entire year of precipitation data comparison for 2011-

2013.  Here, the radar (NEXRAD and PRISM) data were plotted 

on the Y-axis and the rain gauge data on the X-axis.  All slopes 

are less than 1, which suggest that the rain gauge data typically 

measures more precipitation than the radar data.  Dates with 

no recorded precipitation in either of the three datasets were 

removed from the regression analyses.  
 

  Rain Gauge vs 

NEXRAD 

Rain Gauge vs 

PRISM 

Rain 

Gauge 

Rain 

Events 
Slope Adj R2 Slope Adj R2 

YBA 90 0.17 0.22 0.17 0.23 

YIA 81 0.15 0.17 0.16 0.23 

YBD 44 0.14 0.16 0.18 0.18 

Mean  0.15 0.18 0.17 0.21 
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data may be a usable surrogate to 

rain gauge data when investigating 

winter precipitation in semi-arid 

landscapes.  The results also 

showed that NEXRAD is a better 

dataset than PRISM data (0.81 vs 

0.69; Table 9) when plotted 

against the rain gauge data. 

For each of the Rain Gauge 

verse NEXRAD and the Rain Gauge 

Table 9: Winter comparison of precipitation data for years 

2011-2013 (October 1 - April 30).  Since the radar (NEXRAD and 

PRISM) data were plotted on the Y-axis and the rain gauge data 

on the X-axis and all slopes are still less than 1 suggest that the 

rain gauge data typically measures more precipitation than the 

radar data.  Dates with no recorded precipitation in either of 

the three datasets were removed from the regression analyses.  

 

  NEXRAD vs  

Rain Gauge  

PRISM vs 

Rain Gauge  

Rain 

Gauge 

Rain 

Events 
Slope Adj R2 Slope Adj R2 

YBA 40 0.56 0.85 0.59 0.74 

YIA 31 0.57 0.81 0.60 0.77 

YBD 17 0.54 0.76 0.60 0.57 

Mean  0.56 0.81 0.60 0.69 

 

 

 

 

Figure 23:  Plots for winter linear regression models at Yuma Wash looking at the NEXRAD – Rain 

Gauge and PRISM – Rain Gauge comparison. 
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verse PRISM comparisons, the slope of the linear regressions are all less than one (Tables 8 & 9).  Since 

the rain gauge data were plotted on the x-axis, a slope less than one indicates that the rain gauges 

typically measures a larger amount of precipitation than the radar instruments, therefore indicating that 

generally the radar data underrepresents the rainfall quantities by roughly 40% (NEXRAD: 0.56 and 

PRISM: 0.60). 

Rain Gauge and Radar Comparison: Mohave Wash 

The linear regressions for Mohave Wash (Figure 24) which is 45km further away from the NEXRAD 

station shows similar results compared to Yuma Wash.   The average adjusted R2 value for winter 

precipitation is 0.84 with a slope at 0.63.  These data suggest that NEXRAD data is an acceptable 

replacement for rain gauge data at YPG for winter months.  

                  Year  

2011 - 13 

Winter 2011 -13 

Oct 1 – Apr 31 

Rain 

Gauge 

Rain 

Events 
Slope Adj R2 

Rain 

Events 
Slope Adj R2 

MBD 76 0.48 0.32 32 0.70 0.83 

MBA 86 0.28 0.36 37 0.56 0.85 

Mean  0.38 0.34  0.63 0.84 

 

                                                         

Figure 24: Mohave rain gauge and NEXRAD sites with Linear Regression statistics.  Plots are shown 

for the winter analyses only for years 2011-13.  The mean slope and adjusted R2 values for the 

winter analyses are 0.63 and 0.84, respectively.  These values indicate good correlation between 

the rain gauges and the NEXRAD radar data for precipitation during winter months. 
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GHCN Rain Gauge to NEXRAD Comparison 

The linear regression of the larger NEXRAD grids (144km2) to the GHCN Rain Gauge data showed 

similar results for both the year and winter only analyses.  These data appear to measure monsoon 

season precipitation more accurately than the Yuma and Mohave sites (0.54), but less accurately for 

winter precipitation (0.67).  The differences in results from this dataset to Yuma and Mohave datasets 

may be the result of the location, the agglomeration of 9 NEXRAD grids into one, or the increase in 

temporal coverage.  Nevertheless, these data supports that NEXRAD radar data is a suitable 

replacement for rain gauge data during winter months at YPG. 

 

 

 

 

 

 

 

 

Year  

2008 - 13 

Winter 2008 -13 

Oct 1 – Apr 31 

Rain 

Events 
Slope 

Adj 

R2 

Rain 

Events 
Slope 

Adj 

R2 

107 0.49 0.54 52 0.49 0.67 

Figure 25:  Linear Regressions comparing a rain gauge with 9 combined 4 km2 NEXRAD Grids, which 

make a larger 144km2 grid.  The adj R2 for this comparison fell to 0.67 when comparing solely the 

winter data.  When both seasons were considered, the adj R2 reduced to 0.54.  Slope averaged at 

0.49 for both analyses and suggests that the NEXRAD instruments measure roughly 50% of the 

precipitation. 
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APPENDIX D: WINTER NDVI-PRECIP-TEMP CHARTS AND TABLE OF PAIRED T-TESTS BETWEEN CONSECUTIVE DATES 

 

 

Note that the NDVI Ranges are different for the 2004-05 and the 2005-06 Winters compared to the rest of the winters. 

Winter NDVI-PRECIP-TEMP Data: 2004-05 Season Winter NDVI-PRECIP-TEMP Data: 2005-06 Season 

Winter NDVI-PRECIP-TEMP Data: 2006-07 Season Winter NDVI-PRECIP-TEMP Data: 2007-08 Season 
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Winter NDVI-PRECIP-TEMP Data: 2008-09 Season Winter NDVI-PRECIP-TEMP Data: 2009-10 Season 

Winter NDVI-PRECIP-TEMP Data: 2010-11 Season 
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Table 10:  Paired T-Tests between consecutive ΔNDIVI-S (ΔNDVI-S - 1 & ΔNDVI-S - 2) for each winter 

season, where N equals sample size, CI-1 and CI-2 are the lower and upper confidence intervals and the 

Test Estimate is the mean of the difference for Paired T-Test unless denoted by ϮϮ where the Wilcoxon 

signed rank test with continuity correction was used and therefore the (pseudo)median is estimated.  

All but two tests were found to be statistically different (p-value = <<< 0.001) and are denoted by *.  

 

Year ΔNDVI-S - 1  ΔNDVI-S - 2 N CI-1 CI-2 Test Estimate 

2004-05 Oct6Oct6 Oct22Oct6 2354 0.0355 0.0362 0.0358 * 

2004-05 Oct22Oct6 Nov23Oct6 2354 0.0381 0.0394 0.0387 * 

2004-05 Nov23Oct6 Dec9Oct6 2843 0.0265 0.0276 0.0270 * 

2004-05 Dec9Oct6 Dec25Oct6 2843 0.0681 0.0694 0.0688 * 

2004-05 Dec25Oct6 Feb27Oct6 2269 0.0570 0.0631 0.0600 * 

2004-05 Feb27Oct6 Mar15Oct6 2269 -0.0269 -0.0250 -0.0260 * 

2004-05 Mar15Oct6 Mar31Oct6 2843 -0.0708 -0.0688 -0.0698 * 

2004-05 Mar31Oct6 Apr16Oct6 2843 -0.0502 -0.0482 -0.0492 ϮϮ  * 

2004-05 Apr16Oct6 May2Oct6 2843 -0.0171 -0.0167 -0.0169 ϮϮ  * 

2005-06 Oct9Oct9 Nov26Oct9 2843 0.0223 0.0229 0.0226 * 

2005-06 Nov26Oct9 Jan13Oct9 2843 -0.0049 -0.0043 -0.0046 * 

2005-06 Jan13Oct9 Jan29Oct9 2843 -0.0032 -0.0028 -0.0030 * 

2005-06 Jan29Oct9 Apr3Oct9 1911 -0.0194 -0.0186 -0.0190 * 

2005-06 Apr3Oct9 Apr19Oct9 1911 0.0105 0.0109 0.0107 * 

2006-07 Sep26Sep26 Oct12Sep26 2843 0.0320 0.0324 0.0322 * 

2006-07 Oct12Sep26 Oct28Sep26 2843 0.0085 0.0090 0.0087 * 

2006-07 Oct28Sep26 Nov29Sep26 2843 0.0073 0.0079 0.0076 * 

2006-07 Nov29Sep26 Dec31Sep26 2843 -0.0060 -0.0056 -0.0058 * 

2006-07 Dec31Sep26 Jan16Sep26 2843 0.0028 0.0033 0.0031 * 

2006-07 Jan16Sep26 Feb1Sep26 2843 -0.0116 -0.0112 -0.0114 * 

2006-07 Feb1Sep26 Feb17Sep26 2843 -0.0053 -0.0049 -0.0051 * 

2006-07 Feb17Sep26 Apr6Sep26 1477 -0.0060 -0.0054 -0.0057 * 

2006-07 Apr6Sep26 May8Sep26 1477 -0.0002 0.0001 -0.0001  α 

2007-08 Sep29Sep29 Jan19Sep29 2843 0.0402 0.0409 0.0405 * 

2007-08 Jan19Sep29 Mar7Sep29 2823 0.0094 0.0104 0.0099 * 

2007-08 Mar7Sep29 Mar23Sep29 2823 -0.0100 -0.0094 -0.0097 * 

2007-08 Mar23Sep29 Apr8Sep29 2843 -0.0119 -0.0115 -0.0117 * 

2007-08 Apr8Sep29 Apr24Sep29 2843 -0.0045 -0.0042 -0.0043 * 

2008-09 Oct1Oct1 Oct17Oct1 2843 0.0277 0.0281 0.0279 * 

2008-09 Oct17Oct1 Nov18Oct1 2843 0.0080 0.0084 0.0082 * 

2008-09 Nov18Oct1 Jan5Oct1 2800 0.0320 0.0328 0.0324 * 

2008-09 Jan5Oct1 Feb6Oct1 2707 0.0106 0.0117 0.0112 * 

2008-09 Feb6Oct1 Mar10Oct1 2750 0.0082 0.0095 0.0088 * 

2008-09 Mar10Oct1 Mar26Oct1 2843 -0.0332 -0.0321 -0.0326 * 

2008-09 Mar26Oct1 May13Oct1 2843 -0.0226 -0.0218 -0.0222 * 

2009-10 Oct20Oct20 Nov5Oct20 2843 0.0245 0.0249 0.0247 * 

2009-10 Nov5Oct20 Nov21Oct20 2843 0.0055 0.0058 0.0057 * 

2009-10 Nov21Oct20 Jan24Oct20 2843 0.0028 0.0033 0.0030 * 
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Year ΔNDVI-S - 1  ΔNDVI-S - 2 N CI-1 CI-2 Test Estimate 

2009-10 Jan24Oct20 Feb25Oct20 2843 0.0415 0.0429 0.0422 * 

2009-10 Feb25Oct20 Apr14Oct20 2843 -0.0016 0.0003 -0.0006  α  

2009-10 Apr14Oct20 Apr30Oct20 2831 -0.0110 -0.0101 -0.0106 * 

2010-11 Sep5Sep5 Oct7Sep5 2483 0.0301 0.0305 0.0303 * 

2010-11 Oct7Sep5 Dec10Sep5 2483 -0.0074 -0.0067 -0.0071  * 

2010-11 Dec10Sep5 Jan27Sep5 2843 0.0249 0.0260 0.0255 * 

2010-11 Jan27Sep5 Feb12Sep5 2843 -0.0068 -0.0064 -0.0066 * 

2010-11 Feb12Sep5 Feb28Sep5 2843 0.0035 0.0041 0.0038 * 

2010-11 Feb28Sep5 Mar16Sep5 2843 -0.0119 -0.0114 -0.0117 * 

2010-11 Mar16Sep5 Apr1Sep5 2843 -0.0018 -0.0013 -0.0015 * 

2010-11 Apr1Sep5 Apr17Sep5 2843 -0.0084 -0.0080 -0.0082 * 
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APPENDIX E: MON“OON “EA“ON “LOPE ;∆NDVI-S/DAY) FOR EACH RAP FROM 1986-2011 
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APPENDIX F: GEOMORPHIC METHODS TUTORIAL 
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INTRODUCTION 

 

 

 

Semi-arid and arid climates are globally abundant, experiencing a rise in human population and an 

increase in land degradation (Ravi et al., 2010).  The majority of vegetation in these regions is restricted 

to riparian areas which are ephemeral in nature, only experiencing flow events during intense and 

infrequent rain events. Degradation of these riparian areas will undoubtedly have a negative impact on 

the biota and human populations within these regions.  These ecosystems can also be challenging to 

study due to the high annual and interannual variability in precipitation, infrequent stream flow, lack of 

long term data, and the harshness and remoteness of the landscape (Hooke, 2007).   Furthermore, 

studying these regions with interdisciplinary approaches has shown to be beneficial to the overall 

understanding of the system (Newman et al., 2006).  

Characteristics of geomorphology, hydrology, and land cover were calculated at varying scales as 

model parameters among four DoD installations: Fort Bliss (southern New Mexico), Fort Huachuca (SE 

Arizona), Yuma Proving Grounds (YPG, located on the Arizona-California border), and Fort Irwin (SE 

California).  After the parameter processing was completed, the Salford Predictive Modeler Software1 

was used to analyze these data in a Random Forest Statistical Model.  The goal of the modeling was to 

investigate which geo-hydro and vegetative attributes are valuable in describing ephemeral and 

intermittent streams in the Arid Southwest.  All of the data used in creating these databases are freely 

available through various institutions and governmental organizations.  It is important to note that as 

data improves these parameters and variables may be updated with similar methodology as described 

here.  Since these ecosystems are complex this dataset is by no means complete and there are likely to 

be additional parameters or variables that would benefit this analysis. The addition of other parameters 

or different scales may improve model performance and may identify other important aspects in 

describing stream networks.  This document describes the methods regarding the derivation and 

calculation of the suite of data that were created in this analysis.   

 

 

 

 

                                                           
1 http://www.salford-systems.com/ (Salford Systems) 

http://www.salford-systems.com/
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Hierarchical Hydrological Units 

It has long been regarded that describing a system at multiple scales enhances understanding where 

multiple processes (biological, physical or chemical) simultaneously interact at varying spatial and 

temporal scales with each other.  Often times the reasons behind the reach scale channel processes are 

often influenced by larger scale processes such as landcover type, soil characteristics, topography and 

disturbances within the uplands.  The data that was created at varying spatial and temporal scales may 

lead to new insight on the processes that are occurring at the reach scale. 

This methodology focuses on three hydrologic scales, but also takes into account larger spatial 

scales.  The Water Boundary Dataset (WBD) within the NHDPlus Version 2 dataset maps Hydrologic Unit 

Codes (HUCs) at several hierarchical scales across the conterminous US.  The HUC 8 (Subbasin) scale was 

used to isolate the smaller scale hydrologic units (HUC 10, HUC 12 and Catchment).  In these databases, 

the HUC 12 (Watershed Hydrologic Unit) and Catchment (Valley Hydrologic Unit) scales were of primary 

focus and many of the parameters/variables used here were derived at these scales as well as the Reach 

scale.  It is important to note that in certain regions the Catchment dataset is not nested within the HUC 

12 layer and therefore may skew data analyses in these areas.  The Catchment layer is at the heart of 

this problem and is most substantiated at Fort Bliss.  While this should not have an adverse effect on the 

outcomes of this research, it is important to take into consideration when analyzing results or in 

decision making. 
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SPATIAL SCALE CREATION 

 

 

 

Data Acquisition 

The stream networks and varying spatial scales were taken directly from the National Hydrography 

Dataset Plus2 (High Resolution Dataset) and were downloaded by state (Table 1: Flowline & HUC data2).  

This includes the NHD Flowline network, and the hydrologic boundary feature classes: HUC 8, HUC 10 

and HUC 12.  The Catchment layer (NHDPlusV21_XX_XX_NHDPlusCatchment_01.7z) and Flow 

Accumulation Grid (NHDPlusV21_XX_XX_XX_FdrFac_01.7z) were downloaded by the HUC 2 Identifier 

(Table 1: Drainage Area ID, VPU, and RPU) through the Horizon Systems NHD Plus website3.  

 

Table 1: Downloading NHDPlus data from NHDftp2 and Horizon Systems3 website. 

 Flowline & HUC data2 Catchment & Flow Accumulation Grid data3 

Base 
NHD Plus High Resolution 

Dataset 

HUC 2 

Name 

Drainage 

Area ID 

HUC 2 

(VPU) 

Raster Processing 

Unit (RPU) 

Fort Bliss NHDH_NM_931v10.zip  
Rio 

Grande 

RG 
13 13a, 13b, 13c 

Fort 

Huachuca 
NHDH_AZ_931v201.zip 

Lower 

Colorado 

CO 
15 15a 

YPG 
NHDH_AZ_931v201.zip 

NHDH_CA_931v201.zip 

Lower 

Colorado 

CO 
15 15b 

Fort Irwin NHDH_CA_931v201.zip California CA 18 18a 

 

The NHDPlus (High Resolution Dataset) flowline network covers most streams in the US and 

identifies every stream apart of the network with a unique ReachCode identifier.  When a stream 

intersects with another stream, the downstream section receives a new ReachCode identifier.  In this 

research analysis, the streams were split into smaller segments and an underscore and number were 

added to the end of the ReachCode ID.  This became our unique identifier in this study. 

HUC 8, HUC 10, HUC 12, NHDPlus Flowline 

1. Download and Unzip the NHDPlus (High Resolution Dataset), Catchment, and FAC grid data (the 

FAC grid data will be set aside for later use) 

                                                           
2ftp://nhdftp.usgs.gov/DataSets/Staged/States/FileGDB/HighResolution/  (US Geological Survey: 

National Hydrograph Dataset) 
3 http://www.horizon-systems.com/nhdplus/NHDPlusV2_home.php  (Horizon Systems Corporation) 

ftp://nhdftp.usgs.gov/DataSets/Staged/States/FileGDB/HighResolution/
http://www.horizon-systems.com/nhdplus/NHDPlusV2_home.php
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2. Open ARCMap 10.1 and locate the NHDH geodatabase 

(NHDH_XX.gdb)   

3. Under the WBD subfolder in the geodatabase (Figure 

1), import WBD_HU8, WBD_HU10 and WBD_HU12 

into ARCMap 10.1 (the smaller the HUC number, the 

larger the spatial scale) 

4. Upload a boundary of the region of interest 

5. Overlay the Boundary Layer with the WBD_HU8 layer  

6. Use the Select Tool                 to select the intersecting 

WBD_HU8 polygons with the Boundary of interest (Figure 2, Table 2) 

7. Use the Select Tool to extract the HUC 8 polygons that are identified in Table 2 under Analysis -> 

Extract -> Select 

8. Use the Clip Tool to clip the HUC 10 and HUC 12 layers to the boundary of the HUC 8 layer that 

was just created, under Analysis -> Extract -> Clip 

a. Input Features: HUC 10, HUC 12 

b. Clip Features: HUC 8 output 

from the Select Tool 

9. Import the NHDFlowline under the 

Hydrography subfolder (Figure 1) and 

follow Step 8, but with the Flowline 

layer as the input layer 

10. Change Projection of the reduced 

HUC 8, HUC 10, HUC 12 and 

NHDFlowline layers into the 

associated WGS 1984 UTM projection 

(refer to Table 2 for specific 

projection) 

a. To do this, use the Project 

Tool  (Data Management 

Tools -> Projections and 

Transformations -> Feature -> 

Project) 

Figure 1: NHDPlus High Resolution 

geodatabase. 

Figure 2: Selecting the HUC 8 layers that pertain to 

the study area. 
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Table 2: HUC 8 IDs that were selected in Step 6 and designated projection for each feature class in   

the end product. 

 
 

Catchment Layer 

11. Upload the Catchment polygon layer in 

ARCMap 10.1 (Figure 3) 

a. The Catchment layer does not 

exactly match up to the HUC 

boundaries and therefore the 

Select Button            

was used to select 

the Catchment 

polygons that fall 

within the HUC 8 

Boundary files 

(Figure 4)  

12. The Select Tool was used to 

extract the Catchment 

polygons  (Analysis -> 

Extract -> Select) 

13. The layer was re-projected 

as defined in Table 2 and 

Step 10 

Base HUC 8 IDs Extracted in Step 6 
Projected Coordinate 

System 

Fort Bliss 13050003, 13030103, 13060010,      

13050004, 13040100, 13030102 
WGS_1984_UTM_Zone_13N 

Fort 

Huachuca 15050302, 15050202, 15050301 WGS_1984_UTM_Zone_12N 

YPG 15030106, 15030105, 15030104, 

15070201, 15030107, 18100204, 15030108 
WGS_1984_UTM_Zone_11N 

Fort Irwin 18090204, 18090201, 18090207, 18090205, 

18090206, 18090202, 18090208, 18090203 
WGS_1984_UTM_Zone_11N 

Figure 3: Location of Catchment Polygon 

after unzipped. 

Figure 4: Selecting Catchment polygons. 
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Connecting Flowlines with each Watershed Boundary Polygon 

The NHDPlus Flowline layer was intersected with each NHDPlus Watershed Boundary layer so future 

joins between these layers could be easily executed.  The unique common identifiers in Table 3 were 

transferred to the NHDPlus Flowline layer by the Intersecting Tool.  

 

             Table 3: The Fields in the Attribute Table that holds the Unique Identifier in each WBD Layer. 

 

 

 

 

14. Spatial Join Tool was used on each WBD Layer with the NHDPlus Flowline layer (Analysis Tools -

> Overlay -> Spatial Join) 

a. Target Features: NHDPlus Flowline 

Join Features: HUC 8 

Join Operation (optional): JOIN_ONE_TO_ONE 

Match Option (optional): HAVE_THEIR_CENTER_IN 

b. Repeat for HUC 10, and HUC 12 and Catchment 
 

15. In the original NHDPlus Flowline layer 4 new Fields were added by the Add Field button under 

the menu tab              (Figure 5) 

a. Name: HUC8ID  

Type: Text  

Length: 8 

b. Name: HUC10ID  

Type: Text  

Length: 10 

c. Name: HUC12ID  

Type: Text  

Length: 12 

d. Name: GRIDCODE  

Type: Long 

 

***The following Steps (16 to 18) were executed for each individual join before moving on to the next 

join; Step 16 creates the join, Step 17 transfers the data and Step 18 removes the join. 

16. Each WBD layer was joined separately to the NHDPlus Flowline Layer by  

WBD Layer Common Identifier WBD Layer Common Identifier 

HUC 8 HUC_8 HUC 12 HUC_12 

HUC 10 HUC_10 Catchment GRIDCODE 

 Figure 5: Adding Fields in the Attribute Table. 
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a. Right Clicking the NHDPlus 

Flowline layer in the Table of 

Contents; moving curser over 

Joins and Relates, clicking JoiŶ…  

(Figure 6) 

b. In the Join Data GUI, join the 

Common ID of the associated 

field as seen in Table 3 to the 

same Common ID from the 

selected intersected layers 

created in Step 14 (which is set 

in Item 2) 

 

17. The Field Calculator Tool was used to transfer the Common ID from the intersected flowline 

layer to the main flowline layer by right clicking the column header and choosing Field 

CalĐulator…; ͞XXX” represents the name given to the output layers from Step 14; the formulas 

that transferred the Common IDs per WBD Layer are as follows: 

 

a. HUC8ID  = [XXX:HUC_8] 

b. HUC10ID = [XXX:HUC_10] 

c. HUC12ID  = [XXX:HUC_12] 

d. GRIDCODE = [XXX:GRIDCODE] 

 

18. Each Join was removed 

a. Right Click on Layer 

in Table of 

Contents; move 

mouse over Joins 

and Relates, then 

Remove Join(s), 

click on Join to 

remove  (Figure 7) 

 

 

Figure 6: Joining two attribute tables in ArcGIS. 

Figure 7: Removing Join by Right Clicking on Layer in the 

Table of Contents. 
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Reach Layer 

19. The Clip Tool was used to create the Reach layer  (Analysis -> Extract -> Clip); (Figure 8) 

a. Input Features: The re-projected Flowline Layer created in Steps 9 & 10  

b. Clip Features: Boundary Layer (in the same Projection as the Input Features) 

 

20. The ET Geo Wizards Tool was downloaded 

through ET Spatial Techniques4 and 

uploaded into ARCMap 10.1 Toolbox.  This 

tool was used to divide the reaches into 

equal lengths roughly around 1 km  

 

21. The Split Tolerance Tool was used (Note: 

a Licensed is required) 

a. Input: Base Boundary     

           Flowline Layer 

Segment Length: 1 km 

Split Tolerance: Equal Length 

 

22. In the Attribute Table, two new fields 

were created (Step 15,  Figure 5)  

a. Name: ET_ID  

Type: Text  

Length: 5 

b. Name: UniqueID  

Type: Text  

Length: 25 

 

23. The Field Calculator Tool was used to calculate the new columns (Right click on column header 

and choose Field CalĐulator….); the formulas are as follows: 

a. ET_ID  = [FID] 

b. UniqueID = [REACHCODE] & "_" & [ET_ID] 

**The UniqueID is the unique identifier that is used in the rest of this methodology to join and relate 

the Attribute Tables of the associated layers back to the reach scale and to link up the geodatabase 

tables of the end products to the spatial layers. 

                                                           
4 http://www.ian-ko.com (ET SpatialTechniques) 

Figure 8: Clipping the NHDPlus Flowline to the 

base boundary. 

http://www.ian-ko.com/ET_GeoWizards/gw_main.htm
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DERIVATION OF THE HIERARCHICAL SCALE RELATED ATTRIBUTES 

 

 
 

After the HUCs, Catchment, NHDPlus Flowline, and Reach (at the Base scale) were all created, the 

next task was to estimate eco-geo-hydro attributes at each scale using a variety of GIS functions and 

data sources, as identified in Figure 7.  The HUC 8 and HUC 10 layers are at larger scales and therefore 

only a few parameters have been calculated for them.  The HUC 12 or Watershed Scale and Catchment 

layers incorporate data that are generalized to the extents of each polygon. The Reach scale is at the 

smallest scale and generalizes data along each 1km reach that were created in Steps 14 – 18. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 9:  Spatial assignments of each parameter included within the geomorphic dataset.  The items 

in this figure are linked to the area within this document that shows how the data was processed.  
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It is important to note that when some parameters were calculated, they were derived off of or 

have input variables from other parameters, therefore the order that the parameters proceed in is 

important in most cases.   

 

 

HUC 8, HUC 10, HUC 12, and Catchment Metrics 

Length, Width and Area 

The dimensions of the polygon layers within the HUC 8, HUC 10, HUC 12 and Catchment layers were 

estimated to display detail concerning the hydrologic units at each scale.  Length was used to calculate 

the average slope for each hydrologic unit within the spatial layers. 

 

24. The Minimum Bounding Geometry Tool was used to calculate the Length and Width of each 

polygon within each feature class 

a. Input: HUC 8, HUC 10, HUC 12 

Geometry Type (optional): RECTANGLE_BY_AREA option 

Group Option (optional): None 

Check Add geometry characteristics as attributes to output (optional) 

b. The output feature class  maintained each of the input attributes and added 

MBG_Width, MBG_Length, MBG_Orient 

25. Two new fields were added in each NHDPlus Layer (Step 15, Figure 5) 

a. Name: Width_km 

Type: Float  

b. Name: Length_km 

Type: Float 

26. The Main Layer was joined to the Minimum Bounding Geometry output shapefile using the 

Common Identifiers specified in Table 3 (Step 16, Figure 6) 
          

27. The Field Calculator in the Attribute Table was used to transfer the data (refer to Step 17); note 

that the dimensions were in units of meters; dividing by 1000 in the Field Calculator puts the 

diŵeŶsioŶs iŶto kŵ; ͞XXX” represents the name given to the output table from Step 24; the 

formulas used are as follows: 

a. Width_km = [XXX:MBG_Width] / 1000 

b. Length_km = [XXX:MBG_Length] / 1000  

28. The Join was removed (Step 18, Figure 7) 

29. Area was calculated for each Main Layer by adding another Field  (Step 15, Figure 5) 

a. Name: Area_sqkm;  Type: Float 
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30. The area was calculated by right clicking on the 

field that was just created then clicking Calculate 

GeoŵetrǇ… (Figure 10) 

a. Property: Area 

Units: Square Kilometers [sq km] 

 

 

Elevation Max, Elevation Min, Relief Ratio and Slope 

For these parameters, a Digital Elevation Model (DEM) was used. These raster datasets were 

downloaded through the USGS National Map Viewer website5 for each region to the extent of the 

NHDPlus layers.  The specific DEMs used in this analysis were from the National Elevation Dataset (NED) 

1/3 and have a spatial resolution of 10m or 1/3 arc-second and are in an ArcGrid format with units in 

meters.  The DEMs that pertained to each installation were merged for continuous coverage throughout 

the installation and to the extent of the NHDPlus layers.  Each DEM was used to acquire the Elevation 

Max and Min parameters.  The Relief Ratio is simply the range between the highest and lowest elevation 

values within each NHDPlus unit.  The slope (m/m) was determined by dividing the Relief Ratio within 

the specific spatial unit by the length of that unit.   

 

Table 4:  Specific DEM Grid Code IDs (NED 1/3 arc-second) used in estimating Elevation 

and Slope parameters at the HUC extents.  These grid layers were downloaded through 

the USGS: National Map Viewer5. 

Base USGS NED 1/3 arc-second Grid ID 

Fort Bliss 

n31 w105 

n31 w106 

n31 w107 

n32 w105 

n32 w106 

n32 w107 

n32 w108 

n33 w105 

n33 w106 

n33 w107 

n33 w108 

n34 w106 

n34 w107 

n35 w106 

n35 w107 

Fort Huachuca 

n32 w110 

n32 w111  

n32 w112 

n33 w111  

n33 w112 
   

YPG 

n33 w114 

n33 w115 

n33 w116 

n33 w117 

n34 w113 

n33 w114 

n33 w115 

n33 w116 

n33 w117 

n35 w114 

n35 w115 

 

  

Fort Irwin 

n35 w116 

n35 w117 

n35 w118 

n35 w119 

n36 w116 

n36 w117 

n36 w118 

n36 w119 

n37 w116 

n37 w117 

n37 w118 

n37 w119 

n38 w117 

n38 w118 

n38 w119 

 

                                                           
5 http://viewer.nationalmap.gov/viewer/ (US Geological Survey: The National Map Viewer) 

Figure 10: Calculate Geometry for a Field. 

http://viewer.nationalmap.gov/viewer/
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31. The grids shown in Table 4 were downloaded through the USGS National Map Viewer website5 

and unzipped 

32. All DEM grids per study area were uploaded into ARCMap 10.1 

33. All DEM grids were transformed into the WGS 1984 UTM projection as specified by Table 2 and 

Step 10 

34. The Mosaic Tool was used to mosaic all the datasets into one target dataset  (Data 

Management Tools -> Raster -> Raster Datasest ->Mosaic) 

a. Input Rasters: For each base, all but 1 of the Grids mentioned in Table 4  

Target Raster: The remaining Grids not used in Input Rasters, per base 

35. To link up the Elevation Data to each of the NHDPlus Boundary layers, the Zonal Statistics as 

Table Tool was used  (Spatial Analyst Tools -> Zonal -> Zonal Statistics as Table) 

a. Input raster or feature zone data: HUC 8, HUC 10, HUC 12 or Catchment 

Zone field: The Common Identifier shown in Table 3 was used 

Input value raster: Mosaiced DEM created in Step 34 

Statistics type (optional): MIN_MAX 

36. Four new fields were added to each NHDPlus layer (Step 15, Figure 5) 

a. Name: ElevMax_m;   Type: Float  

b. Name: ElevMin_m;   Type: Float 

c. Name: Relief Rat;      Type: Float  

d. Name: Slope;             Type: Float 

37. A join (Step 16, Figure 6) was used to join the Zonal Statistics as Table output table (Step 35) to 

each NHDPlus layer with the Common Identifier shown in Table 3 

38. After joined, the Field Calculator was used to transfer the Min and Max elevation data to the main 

NHDPlus layers; Note, the DEM input data is in meters and therefore the Min Max data is also 

ƌepƌeseŶted iŶ ŵeteƌs; ͞XXX” represents the name given to the output table; the formulas used 

are as follows: 

a. ElevMax_m = [XXX:MAX] 

b. ElevMin_m=  [XXX:MIN] 

39. The Join was removed (See Step 18, Figure 7) 

40. To calculate the Relief Ratio, the Field Calculator Tool was used (see Step 17); the formula used 

is 

a. ReliefRat = [ElevMax_m] - [ElevMin_m]  

41. To calculate Slope, the Field Calculator Tool was used (see Step 17); Note, the units for Relief 

Ratio had to be changed to km; the slope is unitless; the formula used is 

a. Slope = ([ReliefRat] / 1000) / [Length_km] 
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Drainage Density (HUC 10 and HUC 12 only) 

Drainage Density (in units of km/km2) is an important variable as it estimates the ability of a 

watershed to drain, where the larger drainage densities suggest higher peak floods, higher sediment 

yield, and steeper slopes (Dunne & Leopold, 1978; pg 500).  Drainage Density is calculated by summing 

the length of all streams within a drainage area then dividing it by the area of the drainage area.  While 

the NHDPlus Flowline layer is a coarse estimation of many of the streams in the southwest, this 

parameter can still be useful as it is consistent in recording the larger stream types.  A finer Drainage 

Density would have included the smaller streams and braided channels that are not located on the 

NHDPlus Flowline.  Nevertheless, this is important to note as the drainage density derived from the 

NHDPlus dataset are likely to be underrepresented values, which is why we see many values less than 

1.0 km/km2.  A Drainage Density of 0 means there are no stream channels.  In our dataset, this is most 

often seen at Fort Bliss in areas of little to no slope and high infiltration rates.   

 
 

42. NHDPlus Flowline, HUC 10, and HUC 12 layers were opened in ARCMap 10.1  

43. The Intersect Tool was used to join the Flowline layer with the HUC layers  (Analysis Tools -> 

Overlay -> Intersect) 

a. Input Features: NHDPlus Flowline 

                               HUC 10 

Join Attributes (optional): ALL 

Output Type (optional): Input 

44. Step 43 was repeated for the HUC 12 layer 

45.  In the intersected Flowline layers, a new field was added (Step 15, Figure 5)  

a. Name: Length 

Type: Float  

46. CalĐulate GeoŵetrǇ… was used on the field just 

created to calculate the length of all the reaches in 

km  (Step 30, Figure 10) 

a. Property: Length 

Units: Kilometers [km] 

 

47. All non-natural streams were removed, such as 

ditches, canals and pipelines 

a. In the Attribute Table “eleĐt ďy Attriďutes… 

was used; under the menu tab             

(Figure 11)  Figure 11:  “eleĐt BǇ Attƌiďutes… 
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b. This equation was inserted: 

"FTYPE" = 'StreamRiver'   

48. Once all of the StreamRiver FTypes were selected the Select Tool was used, under Analysis -> 

Extract -> Select  

49. The Dissolve Tool was used to dissolve the streams on the HUC 10 and HUC 12 Flowline; where 

the unique Common Identifier was used to dissolve the flowlines on (Data Management Tools -> 

Generalization -> Dissolve) 

a. Input Features: Output from Step 48 (HUC10flowline or HUC12flowline layers) 

Dissolve: Check HUC_10 or HUC_12 depending upon input  

Statistics Field(s) (optional):  

Field:  Length 

Statistics Type:  SUM 
 

50. The Sum_Length from the dissolved layer for the HUC 10 and HUC 12 layers were transferred to 

the main NHDPlus HUC 10 and HUC 12 layers by  

a. Adding a new Field (Step 15, Figure 5) 

i. Name: SumLen_km;   Type: Float 

b. Joining the tables (Step 16, Figure 6) 

c. Using Field Calculator (Step 17) with the formula: 

i. SumLen_km = [XXX:Sum_Length] 

d. Removing the Join (Step 18, Figure 7) 

51. Drainage Density was now calculated 

a. A new field was added to the attribute table in the main NHDPlus HUC 10 and HUC 12 

layers (Step 15, Figure 5) 

i. Name: DrainDen;    Type: Float 

b. Field Calculator (Step 17) was used with the formula:  

i. DrainDen = [SumLen_km] / [Area_SqKm] 

 

GAP Majority and Variety (HUC 10, HUC 12 and CATCHMENT) 

National Gap Analysis Program (GAP)6 data was taken from the Southwest and South Central 

Region.  This raster dataset is delivered in the Albers Conical Equal Area Projection.  The GAP data is 

derived from the Landsat 7 ETM+ satellite imagery from 1999 through 2001 and digital elevation model 

(DEM) datasets.  Each 30m2 cell within the dataset has been assigned an Ecological System or a land use 

                                                           
6 http://gapanalysis.usgs.gov/gaplandcover/ (US Geological Survey, 2011) 

http://gapanalysis.usgs.gov/gaplandcover/
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value and description.  This classification was created through using a decision tree classifier (Gap 

Metadata7).   

The GAP Majority variable estimates the majority of the landcover from the GAP model that occurs 

in each drainage unit within the HUC 10, HUC 12 and Catchment scales.  The values created through 

this method should be considered categorical data and indicate a certain landcover type.  The GAP 

Majority field of the NHDPlus layers can be joined to the GAP raster layer through the Value field to 

identify each landcover type.  The GAP Variety estimates the diversity in landcover types within each 

drainage unit at each scale.  

52. The SW and Southcentral GAP models were downloaded and uploaded into ARCMap 

53. The Southwest and Southcentral GAP models were transferred into the designated projection as 

defined by Table 2 and using the Project Raster Tool  (Data Management Tools -> Projections 

and Transformations -> Project Raster) 

54. The Southwest GAP layers was then clipped to fit the NHDPlus extents by using Extract by 

Masked Tool  (Spatial Analyst Tools -> Extraction -> Extract by Mask) 

55. An extra step was required for Fort Bliss as portions of the study area were located in the 

Southcentral GAP region; Step 54 was repeated using the Southcentral GAP layer 

a. After both GAP rasters were masked, they were merged together through the Mosaic 

Tool (Data Management Tools -> Raster -> Raster Datasest ->Mosaic) 

i. Input Rasters: Foƌt Bliss͛s ƌe-projected and masked Southcentral GAP Target 

Raster: Foƌt Bliss͛s ƌe-projected and masked Southwest GAP 

56. To link up the GAP Data to each of the NHDPlus layers, the Zonal Statistics as Table Tool was 

used  (Spatial Analyst Tools -> Zonal -> Zonal Statistics as Table) 

a. Input raster or feature zone data: HUC 10, HUC 12 or Catchment 

Zone field: Use Common Identifier shown in Table 3 

Input value raster: The associated GAP layer created in Step 54; Bliss: Step 55 

Statistics type (optional): ALL 

57. The Majority and Variety fields from the Tables created in Step 56 for the HUC 10 & 12 and 

Catchment layers were transferred to the associated NHDPlus HUC 10, HUC 12, Catchment 

layers by  

a. Adding two new Fields (Step 15, Figure 5) 

i. Name: GAPmaj;  Type: Long 

ii. Name: GAPvar;  Type: Long 

b. Joining the NHDPlus layer to the appropriate Zonal Statistics Table (Step 21, Figure 8) 

                                                           
7 http://gapanalysis.usgs.gov/gaplandcover/files/2012/09/USGS_GAP_LandCover_Metadata.pdf  (Gap 

Analysis Program, 2010) 

http://gapanalysis.usgs.gov/gaplandcover/files/2012/09/USGS_GAP_LandCover_Metadata.pdf
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c. Using Field Calculator (Step 17) 

i. GAPmaj = [XXX:Majority] 

ii. GAPvar = [XXX:Variety] 

d. Removing the join (Step 18, Figure 7) 

 

Rainfall Seasonality and Modified Fournier Index (HUC 12) 

Rainfall is an important driver in arid landscapes especially when rainfall events are temporally and 

spatially variable.  Characterizing how precipitation events occur annually can be an important indicator 

of channel form, degree of erosibility and impact vegetation especially when rain events are 

concentrated.  The Rainfall Seasonality Index (RS) takes the wettest month and divides it by the annual 

total precipitation and therefore attempts to describe the seasonal differences in rainfall dynamics 

(Equation 1).  Taking the average of monthly rainfall over many years, the RS index will describe the 

climatic seasonality in a region.    

The RS index described above is closely related to the Fournier Index which squares the precipitation 

of the wettest month.  An extension of the Fournier Index, known as the Modified Fournier Index (MFI) 

measures the effects of rainwater on erosion where higher values equate to more erosibility potential 

(Elagib, 2011).  The MFI is classified into five categories: very low (0 – 60), low (60-90), moderate (90-

120), high (120-160) and very high (>160) (Elagib, 2011).  The Modified Fournier Index (MFI) takes the 

sum of the squares of the mean rainfall total per month for the annum then divides it by the mean 

annual precipitation amount (Equation 2).  Several papers have described the MFI as a beneficial 

measure of rainfall erodibility potential using the above criteria (Elagib, 2011). 

 ܴܵ = �௘�௡ �௢௡௧ℎ�� �௥௘௖�௣ ௢௙ �௘௧௧௘௦௧ �௢௡௧ℎ �௘�௡ �௡௡௨�� �௥௘௖�௣  

 

��� = ∑ ቀ ሺ�௢௡௧ℎ�ሻమ�௘�௡ �௡௡௨�� �௥௘௖�௣ቁଵଶ௡=ଵ  

 

The mean monthly and mean annual precipitation data used in the RS and MFI equations were 

derived using the PRISM 30-Year Normals dataset8. The PRISM Data were downloaded through the 

Oregon State University as ASCII layers (13 layers in total) at a 800 meter resolution.  These data were 

calculated using the HUC 12 and reach layer (Steps 106-109), calculating the RS and MFI at the 

watershed and reach scale. The precipitation is downloaded in units of mm*100, so all precipitation 

values should be divided by 100 to convert precipitation to mm. 

                                                           
8 http://www.prism.oregonstate.edu/normals/  (PRISM Climate Group, 2010) 

Equation 1: 

Equation 2: 

http://www.prism.oregonstate.edu/normals/
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58. After the Annual and Monthly 30-Year Normals8 (.asc) data at the 800m resolution were 

download and unzipped, the 13 ASCII layers were uploaded into ARCMap 10.1 

59. The HUC 12 was transferred into the same projection as the PRISM datasets (GCS North 

American 1983) by using the Project Tool (Data Management -> Projections and 

Transformations -> Feature -> Project) 

a. Input: HUC 12 

Output Coordinate System: GCS_North_American_1983 

Output Transformation (optional): WGS_1984_(ITRF00)_To_NAD_1983 

60.  To achieve the precipitation means within each HUC 12 drainage area, the Zonal Statistics as 

Table Tool was used (Spatial Analyst Tools ->Zonal -> Zonal Statistics as Table); Batch tool 

expedited this step; these tables were saved as the first 3 letters: ann, jan, feb, mar, apr, may, 

jun, jul, aug, sep, oct, nov, dec 

a. Input raster or feature zone data: HUC 12 

Zone field: HUC_12 

Input value raster: 1 of the 13 ASCII files downloaded in Step 58 

Statistics type (optional): MEAN 

61. The MEAN precipitation values for each HUC 12 unit from the 13 tables created in Step 60 were 

joined back to the HUC12 shapefile with the GCS coordinate system by 

a. Adding 13 new Fields (Step 15, Figure 5) 

i. Name: Ann; Jan; Feb; Mar; Apr; May; Jun; Jul; Aug; Sep; Oct; Nov; Dec 

Type: Float 

b. Joining each table separately (Step 16, Figure 6) 

c. Using Field Calculator (Step 17); (divide by 100 changes the precipitation into mm) 

i. Ann = [ann:MEAN]/100 

ii. Jan = [jan:MEAN]/100 

iii. Et Đeteƌa… 

d. Remove each join (Step 18, Figure 7) 

62. The Attribute Table of the HUC 8 with each annual and monthly mean precipitation value was 

then extracted into a .dbf file (Select the menu button            in the attribute table, then Eǆport… 

and save as a dBASE Table) 

63. The .dbf file was uploaded into Excel 

a. In the adjacent cell to the Dec column, the =MAX() function was used to pull out the 

Highest Precipitation Value for all months (the Ann column was not included in this 

formula)  

b. In the next column, the Rainfall Seasonality (RS) was calculated by dividing the Highest 

Precipitation Value by the Annual Precipitation Value 
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c. In the next column, the Modified Fournier Index (MFI) was calculated by following the 

MFI formula described in Equation 2 

64. The Excel document was saved, uploaded into ARCMap and the RS and MFI data were 

transferred to the main HUC 12 layer by  

a. Adding 2 new Fields (Step 15, Figure 5) 

i. Name: RainfallSeas 

Type: Float 

ii. Name: ModFournier 

Type: Float 

b. Joining the HUC 12 to the excel (dbf) table (Step 16, Figure 6) 

c. Using Field Calculator (Step 17) 

i. RainfallSeas= [XXX:RS] 

ii. ModFournier= [XXX:MFI] 

d. Removing the join (Step 18, Figure 7) 

 

Weather Products Texture (HUC 12) 

The Weathered Products Texture (WPT) parameter is a measure of the geologic parent material and 

is used to explain the availability of sediment potential within the watershed.  This parameter is based 

off of the USGS Mineral Resources Program: Geology Datasets, where the categories in the Rock Type 1 

field were simplified into four categories: Unconsolidated, Coarse, Fine and Unknown (for rock type 

assignment refer to Appendix: A). These USGS GIS layers were compiled from State Geology maps and 

can be downloaded per state9. The digital geology ARC layers for California10, Arizona11, New Mexico12 

and Texas13 were downloaded (ArcView shapefiles: XXgeol_dd.zip). Background information about these 

layers and attributes tables can also be found at 

http://pubs.usgs.gov/of/2005/1351/documents/CONUSDocumentation.pdf. 

 

65. The GIS versions of the State Geology layers were downloaded, unzipped and the 

XXgeol_dd_polygon.shp layer was uploaded into ARC GIS 

66. An extra step was needed at Fort Bliss, where the Texas and New Mexico geology layers were 

merged together by using the Merge Tool (Data Management -> General -> Merge) 

                                                           
9 For New Mexico and Texas: http://pubs.usgs.gov/of/2005/1351/ (Stoeser et al. 2007).  For California 

and Arizona: http://pubs.usgs.gov/of/2005/1305/ (Lundington et al. 2007) 
10 California Geology Layers (http://pubs.usgs.gov/of/2005/1305/#CA): CAgeol_dd.zip 
11 Arizona Geology Layers (http://pubs.usgs.gov/of/2005/1305/#AZ): AZgeol_dd.zip 
12 New Mexico Geology Layers (http://pubs.usgs.gov/of/2005/1351/#NM): NMgeol_dd.zip 
13 Texas Geology Layers http://pubs.usgs.gov/of/2005/1351/#TX): TXgeol_dd.zip 

http://pubs.usgs.gov/of/2005/1351/documents/CONUSDocumentation.pdf
http://pubs.usgs.gov/of/2005/1351/
http://pubs.usgs.gov/of/2005/1305/
http://pubs.usgs.gov/of/2005/1305/#CA
http://pubs.usgs.gov/of/2005/1305/#AZ
http://pubs.usgs.gov/of/2005/1351/#NM
http://pubs.usgs.gov/of/2005/1351/#TX
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67. The Project tool was used to convert the geology shapefile into the same projection as the HUC 

12 layer as documented in Table 2 (Data Management Tools -> Projections and Transformations 

-> Feature -> Project) 

68. The Clip Tool was used to clip the geology layer to the HUC extents (Analysis Tool -> Extract -> 

Clip) 

69. The Geology polygons were then dissolved on the ROCKTYPE1 field using the Dissolve Tool 

(Data Management ->Generalization -> Dissolve) 

a. Input Features: Geology Layer 

Dissolve_Field(s) (optional): check ROCKTYPE1 

70. A new field was added into the attribute table of the dissolved geology layer (Step 15, Figure 5) 

a. Name: WPT 

Type: Text;  Length: 50 

b. The four categories were added to the new field: Unconsolidated, Coarse, Fine and 

Unknown to reflect Appendix: A by using the Editor Tool  (Right click on layer in Table of 

Contents-> Edit Features -> Start Editing) 

71. The Dissolve Tool was preformed again to aggregate the WPT classes (Data Management -> 

Generalization -> Dissolve) 

a. Input Features: Geology Layer 

Dissolve_Field(s) (optional): check WPT 

72. The geology polygon layer that stores the WPT field was then converted into a raster using 

Polygon to Raster Tool (Conversion Tools -> To Raster -> Polygon to Raster) 

a. Input Features: geology layer created in Step 71 

Value field: WPT 

Cell assignment type (optional): Cell_Center 

Priority field (optional): NONE 

Cellsize (optional): 0.0001 

73. Zonal Statistics as Table Tool was used to find the majority of the WPT index from the geology 

raster (Spatial Analyst Tools -> Zonal -> Zonal Statistics as Table) 

a. Input raster or feature zone data: HUC 12 

Zone field: WPT 

Input value raster: geology raster from Step 72 

Statistics type (optional): MAJORITY 

 

 

 



100 

 

74. Since the Zonal Statistics calculated the Value field, the WPT has to be associated to the Value 

field; this was done by  

a. Adding a new Field in the Zonal Statistics Geology Table (Step 15, Figure 5) 

i. Name: WPT 

Type: Text 

Length: 50 

b. Joining the Majority field in the Zonal Statistics Geology Table to the Value field in the 

geology raster (Step 16, Figure 6) 

c. Using Field Calculator (Step 17) 

i. WPT = [XXX:WPT] 

d. Removing Join (Step 18, Figure 7) 

75. The WPT field from the Zonal Statistics Geology Table was transferred to the main HUC 12 layer 

by 

a. Adding a new Field in the HUC 12 layer (Step 15, Figure 5) 

i. Name: WPT 

Type: Text 

Length: 50 

b. Joining the HUC 12 layer to the Zonal Statistics Table (Step 16, Figure 6) 

c. Using Field Calculator (Step 17) 

i. WPT = [XXX:WPT] 

d. Removing Join (Step 18, Figure 7) 

 

NOAA Depth-Duration-Frequency (HUC 12) 

The Depth-Duration-Frequency (DDF) estimates the depth of rainfall during extreme precipitation 

events as a function of duration for a specified return period.  The frequency and magnitude of these 

events can be a major driver of fluvial geomorphological processes such as channel formation and 

sediment movement.  The DDF estimates were calculated for rainfall depths at duration and frequency 

intervals of 10yr-30min, 10yr-60min, 10yr-2hr, 25yr-30min, 25yr-60min and 25yr-2hr; where the 10yr 

recurrence intervals have an annual exceedance14 probability of 0.10 or a 10% chance of this type of 

event occurring each and every year; whereas the 25yr recurrence intervals have a probability of 

occurring of 0.04 or 4% chance each and every year (Dunne & Leopold, 1978, p 52-53). 

                                                           
14 Annual exceedance is a measure of a sample of all annual extreme rain events of a certain duration 

interval at a measuring station (Dunne & Leopold, 1978, p 52). 
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   The Precipitation Frequency raster data used in this research were developed through the 

Hydrometeorological Design Studies Center within the Office of Hydrologic Development of National 

OĐeaŶiĐ aŶd AtŵospheƌiĐ AdŵiŶistƌatioŶ͛s ;NOAAͿ NatioŶal Weatheƌ “eƌǀiĐe ;NW“Ϳ aŶd aƌe diǀided 
into volumes based on geographic location (Office of Hydrologic Development, 2014)15.  At each DDF 

interval, the Semiarid Southwest (NOAA Atlas 14 Volume 1) were downloaded in ASCII grid format and 

used on the associated installations.  The resolution of this data is at 889 meters and is delivered in 

precipitation values of inches*1000 (to put precipitation in interval form).  The precipitation was 

transferred into mm with three significant figures.  

Since Fort Bliss includes areas in Texas, DDF values for Texas had to be sourced separately through 

the USGS: Atlas of Depth-Duration Frequency of Precipitation Annual Maxima for Texas16 contour 

maps (Asquith & Roussel, 2004).  Within this document contains the DDF contour maps at varying 

duration and time scales.  The precipitation depths were taken at the same six Duration-Frequency 

scales as the NOAA DDF datasets and are documented in intervals at a tenth of an inch.  This was 

approximated by geo-referencing the contour maps and using the Editor Tool in ARCMap to add in the 

values.  The DDF values were transformed into millimeters and rounded to two significant figures.   

76. The raster files from the NOAA Atlas 14 Volume 1 (Semiarid Southwest): Precipitation 

frequency estimates: Annual Maximum Series data were downloaded at each DDF interval and 

unzipped 

a. Annual exceedance probability: 1/10   (10 year) 

i. Duration: 30-minute, 60-minute and 2-hour 

b. Annual exceedance probability: 1/25   (25 year) 

i. Duration: 30-minute, 60-minute and 2-hour 

77. After layers were brought into ARCMap 10.1, the Define Projection Tool was used to put the 

DDF grids into the same projection (GCS North American 1983) as the HUC 12 layer created in 

Step 59  (Data Management -> Projections and Transformations -> Define Projection)  

78. To achieve the DDF means for each of the six intervals within each HUC 12 drainage area, the 

Zonal Statistics as Table Tool was used (Spatial Analyst Tools ->Zonal -> Zonal Statistics as 

Table); Batch tool expedited this step; these tables were saved as sw10y30m, sw10y60m, 

sw10y2hr, sw25y30m, sw25y60m, and sw25y2hr, respectively 

a. Input raster or feature zone data: HUC 12 (with GCS North American 1983 projection) 

Zone field: HUC_12 

Input value raster: 1 of the 6 DDF grids 

Statistics type (optional): MEAN 

                                                           
15 NOAA Atlas 14 Precipitation Frequency Estimates in GIS Compatible Format: NOAA Atlas 14 Volume 1 

– Semiarid Southwest (sw) (http://hdsc.nws.noaa.gov/hdsc/pfds/pfds_gis.html) 
16 USGS: Atlas of Depth-Duration Frequency of Precipitation Annual Maxima for Texas: 

http://pubs.usgs.gov/sir/2004/5041/  (Asquith & Roussel, 2004) 

http://hdsc.nws.noaa.gov/hdsc/pfds/pfds_gis.html
http://pubs.usgs.gov/sir/2004/5041/
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79. The MEAN precipitation values for each HUC 12 unit from the 6 tables created in Step 78 were 

joined back to the main HUC12 shapefile 

a. Adding 6 new Fields (Step 15, Figure 5) 

i. Name: sw10y30m, sw10y60m, sw10y2hr, sw25y30m, sw25y60m, sw25y2hr 

Type: Float 

b. Join each table separately (Step 16, Figure 6) 

c. The following formulas were used in Field Calculator (Step 17) to convert the 

precipitation to mm and round it to the nearest tenth of a millimeter  

i. sw10y30m = Round(([sw10y30m:MEAN]/1000*25.4), 1) 

ii. sw10y60m = Round(([sw10y60m:MEAN] /1000*25.4), 1) 

iii. Et Đeteƌa… 

d. Each join was removed (Step 18, Figure 7) 

80. Fort Bliss required an extra step where the USGS: Atlas of Depth-Duration Frequency of 

Precipitation Annual Maxima for Texas contour maps were used 

a. The DDF images were saved as a jpeg, then uploaded into ARCMap 10.1 

b. The images were georeferenced by adding at least 4 control points to each of the 6 DDF 

maps, (Customize tab -> Toolbars -> Georeferencing) 

c. Editor Tool was used on the HUC12 layer (Right click on layer in Table of Contents-> Edit 

Features -> Start Editing)  

i. The main HUC 12 layer was overlaid on each of the DDF contour map jpg  

ii. The average value for each DDF map was inputted into each HUC 12 polygon 

that overlaid with Texas in mm; Roughly in between the contour lines, DDF 

values were averaged; all values were rounded to 2 significant figures 

 

Annual Flood Frequency, Drainage Condition Index, Hydrologic Group, K Factor (Catchment) 

The Annual Flood Frequency, Drainage Condition Index, Hydrologic Group and K Factor variables are 

products of the STATSGO and SSURGO datasets that were acquired per region of interest through the 

NRCS Geospatial Data Gateway Portal17.  The STATSGO GIS data is given on state scales, while the 

SSURGO data has a much finer resolution and is frequently mapped at the county level but is not 

continuous throughout the US.   Where the SSURGO dataset was absent, the STATSGO dataset was 

used.  

                                                           
17 http://datagateway.nrcs.usda.gov/  or   

          http://websoilsurvey.nrcs.usda.gov/app/WebSoilSurvey.aspx (Soil Survey Staff) 

http://datagateway.nrcs.usda.gov/
http://websoilsurvey.nrcs.usda.gov/app/WebSoilSurvey.aspx
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Annual Flood Frequency (see Supplement B) estimates the approximate number of times flooding 

occurs over a time period for a given area (USDA n.d., 618.30).  There are a total of six Flood Frequency 

Classes, however majority of the areas observed in this study have very little flooding possibilities and 

fall into the None (< 1% chance of occurring within 100 yrs, but >1% occurring in 500yrs) flood frequency 

class, occasionally areas have slightly higher flood frequency potentials and are documented by the Very 

Rare (<1% chance of occurring within 100yrs) and Rare (1-5% chance of occurring within 100yrs) flood 

frequency classes.  Fort Huachuca has a few regions that fall within the Occasional Flood Frequency 

Class where flooding has a 5-50% chance of occurring within 100 years (USDA n.d., 618.30).  The flood 

frequency variable derived in this analysis is based off of the dominant Annual Flood Frequency class 

within each SSURGO/STATSGO mapunit. 

The Drainage Condition Index consists of 7 classes that are based off of landscape position and soil 

morphology and refers to the natural drainage condition of the soil.  The classes range from Excessively 

Drained to Very Poorly Drained (See Supplement B) which provides information regarding the limitations 

and potentials of soil (USDA n.d., 618.18).  The drainage variable used in this analysis was based off of 

the dominant Drainage Condition within each SSURGO/STATSGO mapunit. 

The Hydrologic Groups are split into four distinct categories (A, B, C, or D) that display similar runoff 

patterns (See Supplement B).  These classes are based off of information pertaining to intake and 

transmission of water under the conditions of maximum yearly wetness, unfrozen soil, bare soil surface 

and maximum swelling of expansive clays; with the principle idea that soils found within a climatic 

region should be similar in the following factors: depth of a restrictive layer (includes water table), 

transmission rate of water, soil texture, structure and degree of swelling when saturated (USDA Natural 

Resources Conservation Services, 2007).   To summarize, Group A soils generally allow water to flow 

freely through the soil, has a low runoff potential even when soil is thoroughly wet and generally has 

less than 10% clay and more than 90% of sand or gravel; Group B soils generally allow water to transmit 

through soil unimpeded, therefore having moderately low runoff potential even when thoroughly wet, 

and generally consist of 10-20% clay and 50-90% sand with some loamy sand or sandy loam textures; 

Group C soils have constrained water transmission rates causing a moderately high runoff potential 

when thoroughly wet, and are usually 20-40% clay and less than 50% sand with possibilities of loam, silt 

loam, sandy clay loam, clay loam, clay loam, and silty clay loam present; Group D soils have very poor 

water transmission rates through the soil causing high runoff potential when thoroughly wet, with 

greater than 40% clay, less than 50% sand and have clayey textures (USDA Natural Resources 

Conservation Services, 2007).     

The KF factor is considered a soil erodibility factor that quantifies the ability of soil less than 2.0 mm 

(fine earth) to detach from the substrate via runoff and raindrop impact (USDA, n.d., 618.58).  The KF 

factor is based off the interactions between five soil properties:  

1) Percent of silt plus very fine sand 

2) Percent of sand greater than 0.10mm  

3) Organic matter content 

4) Soil structure 

5) Saturated Hydraulic Conductivity 
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 The KF factor is a categorical data made up of 14 classes; 0.02. 0.05, 0.10, 0.15, 0.17, 0.20, 0.24, 0.28, 

0.32, 0.37, 0.43, 0.49, 0.55 and 0.64; where the spread of these classes represents the uncertainty 

associated with the K value, such that 0.10 has + 0.025 units of uncertainty (USDA, n.d., 618.58). 

 Both the SSURGO and STATSGO spatial and tabulated data per region of interest were downloaded.  

The tabulated data was opened in the Microsoft Access SSURGO template supplied with the download 

through the NRCS Data Gateway website (http://datagateway.nrcs.usda.gov/).  After the tabulated 

database was connected to Microsoft Access, it was then usable in ARCmap.  The muaggatt component 

and chorizon files hold the relevant fields.  

 

81. Download all relevant SSURGO and STATSGO data from the NRCS Data Gateway site 

82. The soils data were unzipped as well as the soildb_US_2002 zip folder that is nested within 

83. The Access database files were opened and the location of the tabulated folder was inputted 

into the SSURGO Import GUI (this enabled the soils databases to be useable in ARCMap  

84. The spatial data of the STATSGO/SSURGO dataset as well as the corresponding muaggatt, 

component, and chorizon tables from the soildb_US_2002 access database were brought into 

ARCMap 10.1  

85. Five new fields were added to the soils shapefile (Step 15, Figure 5) 

a. Name: HydroGrp 

Type: Text 

Length: 5 

b. Name: Drainage 

Type: Text 

Length: 50 

c. Name: FldFreq 

Type: Text 

Length: 25 

d. Name: cokey 

Type: Text 

Length: 30 

e. Name: KFfact 

Type: Text 

Length: 5 

86. The muaggatt table was joined (Step 16, figure 6) through the mukey field to the soils shapefile; 

field calculator (Step17) was used to transfer the hydgrpdcd to the newly created HydrGrp field, 

http://datagateway.nrcs.usda.gov/
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drclassdcd to the newly created Drainage field, and flodfreqdcd to the new FldFreq field; then 

the join was removed (Step 18, Figure 7) 

87. Similarly to Step 86, the component table was joined to the soils shapefile through the mukey so 

that the cokey could be transferred to the newly created cokey field; then the join was removed 

88.  Similarly to Step 86, the chorizon table was joined to the soils shapefile through the cokey from 

the previous step, which allowed the kffact field to be transferred to the KFfact field in the soil 

shapefile; then the join was removed 

89. Steps 81 to 88 were repeated for each soils layer in the study areas; a Merge Tool (Data 

Management -> General -> Merge) was used to merge all of the SSURGO shapefiles together 

and where there was a lack of coverage from the SSURGO dataset, the STATSGO dataset was 

added (the Erase and Merge Tool was used to add in the non-overlapping dataset) 

90. The final product of Step 89 was re-projected in the comparable HUC extent projection (Table 2, 

Step 10) then clipped to the NHDPlus WBD extents (Step 19, Figure 8) 

91.  The merged soils shapefile was dissolved on each of the following fields: HydroGrp, Drainage, 

FldFreq and KFfact fields individually by using the Dissolve Tool (Data Management Tools -> 

Generalization -> Dissolve) to create four new shapefiles 

a. Input Features: Soils shapefile 

Dissolve Field: check one of the four fields mentioned above, individually 

92. For each of the four dissolved layers 

created in Step 91, the Select Tool 

(Analysis Tools -> Extract -> Select) was 

used to remove the category with no data 

or in the case of the KF factor, the zeros; 

this was done by selecting all the non-

empty categories (Figure 12) 

93. Each of the four dissolved shapefiles were 

transferred to a raster using the Polygon 

to Raster Tool (Conversion -> To Raster -> 

Polygon to Raster) 

a. Input Features: one of the four 

dissolved shapefile from Step 92 

Value field: the corresponding dissolved field (HydroGrp, Drainage, FldFreq or KFfact) 

CellSize: 20 

Figure 12: Using Select Tool to remove out the 

empty data. 
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94. To link up each of the soils data to each of the Catchment layers, the Zonal Statistics as Table 

Tool was used (Spatial Analyst Tools -> Zonal -> Zonal Statistics as Table) 

a. Input raster or feature zone data: Catchment 

Zone field: GRIDCODE 

Input value raster: Each Raster layer created in Step 92, individually 

Statistics type (optional): MAJORITY 

95. The output tables from Step 94 had to have the categorical data transfer back into them 

a. Each table had a new field added (Step 15, Figure 5)   

i. Name: maj 

 Type: Text 

 Length: 50 

b. Each table was joined (Step 16, Figure 6) to the corresponding raster grid using the 

MAJORITY field from the Table and the VALUE field from the raster  

c. Field calculator was used to transfer the categories from the raster to the maj field for 

each table (Step 17) 

d. Each join was removed (Step 18, Figure 7)   

96. The same fields in Step 85 were added to the Catchment Layer 

97. Each table was joined individually (Step 16, figure 6) to the Catchment layer through the 

GRIDCODE field; field calculator (Step 17) was used to transfer the maj to the corresponding 

newly created fields in the Catchment layer; then the joins were removed (Step 18, Figure 7) 

 

Reach Metrics 

Rock Type and Lithology  

The Rock Type and Lithology can be important metrics in indentifying the type and character of the 

substrate and can also suggests distinctive weathering patterns.  Within the USGS Mineral Resources 

Program: Geology Datasets, these metrics portray the dominant Rock or Lithology types and are 

displayed in a hierarchal order ranging from ROCKTYPE1 to ROCKTYPE2 and LITH 1 to 5, where 

ROCKTYPE1 and LITH1 document the most dominant type. The USGS does note that the Geology Map 

Units are mapped on a relatively large scale (by state) and may force certain groupings to generalize the 

data at these scales and therefore may cause a generalization of the lithology categories; consequently, 

it is common that many of the Map Units contain more than one lithology (Lundington et al., 2007 & 

Stoeser, et al., 2007).  Here LITH1 and LITH2 are assigned to each reach to help display the multiple 

lithologies.   
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Previously, ROCKTYPE1 was consolidated into the Weathers Texture Products in Steps 65 - 75.  The 

same XXgeol_dd_polygon layers that were downloaded for the WPT metric from the USGS Mineral 

Resources Program: Geology Datasets were also used here.  On the same website, the dbf file for each 

geology dataset was downloaded18.  This dbf zipfile contains the lithology information that was linked to 

the geology shapefile through the UNIT_LINK field in both tables. 

 

98. The same shapefile that was downloaded (for Fort Bliss, Texas and New Mexico were merged) 

and re-projected in Steps 65 – 68 was uploaded into ARCMap 10.1 

99. Three new fields were added to the geology shapefile at each base  (Step 15, Figure 5)  

a. Name: LITH1 

Type: Text 

Length: 50 

b. Name: LITH2 

Type: Text 

Length: 50 

c. Name: LITH_FORM 

Type: Text 

Length: 50 

100. The [State] .dbf file that was downloaded from the same USGS website (see footnote 18) as the 

geology shapefile was unzipped and the  XXLITH.dbf file was uploaded into ARCMap 10.1 

101. A join was created between the shapefile and the XXLITH.dbf file through the UNIT_LINK field 

(Step 16, Figure 6) 

102. The LITH1, LITH2 and LITH_FORM fields were transferred to the geology shapefile through Field 

Calculator (Step 17) and the join was removed (Step 18, Figure 7)  

103. A point shapefile was created that contained the midpoints of each reach by  

a. Creating an x and y field (float) within the reach layer  

b. Using calculate geometry tool (Step 30, Figure 10) to acquire the x and y coordinates of 

the midpoints of each reach  

c. Exporting the attribute table as a dbf file (Select the menu button            in the attribute 

table, then Eǆport… and save as a dBASE Table) 

                                                           
18 California Geology Layers (http://pubs.usgs.gov/of/2005/1305/#CA): California dbf files;  
Arizona Geology Layers (http://pubs.usgs.gov/of/2005/1305/#AZ): Arizona dbf files;  
New Mexico Geology Layers (http://pubs.usgs.gov/of/2005/1351/#NM): New Mexico dbf files;  
Texas Geology Layers http://pubs.usgs.gov/of/2005/1351/#TX): Texas dbf files 

http://pubs.usgs.gov/of/2005/1305/#CA
http://pubs.usgs.gov/of/2005/1305/#AZ
http://pubs.usgs.gov/of/2005/1351/#NM
http://pubs.usgs.gov/of/2005/1351/#TX
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d. In ARC Catalog, the mouse was 

moved over the exported file; 

right clicked; then Create Feature 

Class and Froŵ XY Taďle… was 

selected (Figure 13); in the next 

GUI, the x and y fields were 

selected accordingly. 

i. The new point layer 

was projected into the 

same projection as the geology layer 

104. The point layer was intersected with the geology layer (Analysis Tools -> Overlay -> Intersect) 

105. The ROCKTYPE1, ROCKTYPE2, LITH1, LITH2 and LITHFORM of the intersected point layer was 

transferred back to the main reach Flowline layer by 

a. Adding the fields (Step 15, Figure 5) to the Reach Flowline layer 

i. Name: ROCKTYPE1 

Type: Text 

Length: 50 

ii. Name: ROCKTYPE2 

Type: Text 

Length: 50 

iii. Name: LITH1 

Type: Text 

Length: 50 

iv. Name: LITH2 

Type: Text 

Length: 50 

v. Name: LITH_FORM 

Type: Text 

Length: 50 

b. Joining the tables through the UniqueID (Step 16, Figure 6) 

c. Using Field Calculator to transfer each of the 5 geology metrics to the reach network 

(Step 17) 

d. Removing the join (Step 18, Figure 7) 

 

 

Figure 13:  Creating a Feature Class from a dbf file. 
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Rainfall Seasonality and Modified Fournier Index 

The monthly PRISM grid layers were used to determine the Rainfall Seasonality (RS) and the 

Modified Fournier Index (MFI) of each reach.  Calculating this metric at the reach scale may show more 

subtle changes within the differences in the average precipitation than as generalized at the Watershed 

(HUC 12) scale.  Similar methods were utilized as described in the Rainfall Seasonality and Modified 

Fournier Index of the HUC 12 layer (Steps 58 – 64); however, here the tool Extract Multi Values to Points 

was employed with the reach midpoint shapefile.  

106. The Annual and Monthly 30-Tear Normals19 (.asc) data at the 800m resolution that were 

download in Step 58, were uploaded into ARCMap 10.1 (13 ASCII layers) 

107. The midpoint shapefile that was created in Step 103  was transferred into the same projection 

as the PRISM datasets (GCS North American 1983) by using the Project Tool (Data Management 

-> Projections and Transformations -> Feature -> Project) 

a. Input: Reach Midpoint Layer 

Output Coordinate System: GCS_North_American_1983 

Output Transformation (otional): WGS_1984_(ITRF00)_To_NAD_1983 

108. Extract Multi Values to Points Tool was used to add the monthly and annual precipitation 

values as each point (Spatial Analyst Tools -> Extraction -> Extract Multi Values to Points) 

a. Input point features: Reach Midpoint Layer in GCS projection 

Input rasters: Annual and All months (together), named appropriately 

109. The same methods were followed as described in Steps 61 -64; except the attribute table of the 

layer that was created in Step 108 was used instead of the HUC 12 layer 

 

 

                                                           
19 http://www.prism.oregonstate.edu/normals/  (PRISM Climate Group, 2010) 

http://www.prism.oregonstate.edu/normals/
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Reach Width at 0.25, 0.5, 1, 2 and 3 meters 

The widths of streams at varying depths 

(Figure 14) can be an important indicator of 

channel hydro-geomorphology and may be 

able to measure hydrologic influences such as 

bankfull width or channel incision.  In this 

study, the mean widths at the various 

inundation depths were calculated at each 

reach segment.  The HGVC (Hydro-Geomorphic 

Valley Classification) extension tool (Carlson 

E.A., 2009)  was used in ARCmap 10.1 to 

calculate the width at different assigned 

inundated depths.  To create these layers, a 

DEM (LiDAR or 10m DEM) and flowline 

shapefile were used with the Optional 

Inundation Depth Tool.  The widths were 

calculated for 0.25, 0.5, 1.0, 2.0 and 3.0m. 

 

110. The Reach Flowline Layer and DEM were uploaded into ARCMap 10.1 

111. The LiDAR or DEM were re-projected into the associated spatial reference listed in Table 2 

112. The HGVC 9.3 Toolset was added into ARCToolbox (by right clicking in ARCToolbox, selecting Add 

Toolďox… and navigating to location on computer), then the Optional: Inundation Tool was 

opened (HGVC 9.3 Toolset -> Valley Segment Creation -> Optional: Inundation Depth) 

a. INPUT: Filled Surface Raster: LiDAR or DEM (filled or unfilled) 

INPUT: Stream Network Raster: Reach Flowline Layer 

INPUT: Unique Valley Analysis Area Shapefile: Base Boundary 

Flood Depth (m) (optional): 3, 2, 1, 0.5, 0.25 (individually) 

i. NOTE: a filled surface raster will generally produce larger polygons in areas 

where pools exist; this may be more prominent in other regions where water is 

less ephemeral 

113. A 200 m buffer of the flowline was created to segment the inundated layers back into the reach 

segments (Analysis Tools -> Proximity -> Buffer) 

a. Input Features: Reach Flowline 

Distance [value or field]: 200 meters 

Side Type (optional): FULL 

End Type (optional): FLAT 

Dissolve Fields (optional): NONE 

Figure 14:  Inundated polygons at different depths 

at Fort Huachuca using the HGVC tool and LiDAR as 

the Digital Elevation Model. 
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114. The Inundation Layer was clipped to the Reach Buffer Layer (Analysis Tools -> Extract -> Clip) 

a. Input Features: Buffered Reach Layer (Step 113) 

Clip Features: 3m Inundation Layer (Step 112) 

115. The output layer from Step 114 was manually edited to remove extraneous portions of the 

stream segments that were clipped near adjacent streams or confluences 

a. The Intersect tool was useful here to find areas of overlap within the inundated reach 

polygon layer (Analysis Tools ->Overlay -> Intersect); Input Features: the inundation 

reach layer by itself 

116. Once the 3m inundation layer was completely edited, the 2m Inundation Layer was clipped  

(Analysis Tools -> Extract  -> Clip) 

a. Input Features: Edited 3m Inundation Layer (Step 115) 

Clip Features: 2m Inundation Layer (Step 112) 

b. Step 115 was re-executed for the 2m Inundation Reach output  

117. Step 116 was repeated for the 1, 0.5, and 0.25m using the corresponding Input and Clip 

features for each inundation depth 

118. Two new Fields were added into each of the finalized inundation layers (Step 15, Figure 5)  

a. Name: Area_sqm;  Type: Float 

b. Name: Width_m;   Type: Float 

 

119.  For the Area_sqm field, Calculate Geometry was used to determine the area of each reach 

polygon (Step 30, Figure 10) 

a. Property: Area 

Units: Square Meters [sqm] 

120. For the Width_m field in each Inundated Reach Layer, Field Calculator (Step 17) was used 

a. Width_m= [Area_sqm] / [Length_m] 

121. In the main Reach Flowline Layer, five new fields were added  (Step 15, Figure 5)  

a. Name: Width3m, Width2m, Width1m, Width0_5m, and Width0_25m 

Type: Float 

122.  The inundated widths were transferred to the main Reach Flowline Layer by 

a. Joining each Inundated Table through the UniqueID (Step 16, Figure 6) 

b. Using Field Calculator (Step 17) to transfer the Width_m field to the associated field 

created in Step 121 

c. Each Join was removed (Step 18, Figure 7) 
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National Flood Frequency: Linear Regression Equations 

The relevant documents that display the Linear Regression Equations were downloaded through the 

USGS Publications Warehouse.  The documents used for Fort Bliss were The Analysis of the Magnitude 

and Frequency of Peak Discharge and Maximum Observed Peak Discharge in New Mexico and 

Surrounding areas20 and The National Flood-Frequency Program – Methods for Estimating Flood 

Magnitude and Frequency for Natural Basins in Texas, 200121.  For Fort Irwin, the document used was 

Methods for Determining Magnitude and Frequency of Floods in California, Based on Data through 

Water Year 200622.  For YPG and Huachuca, the document The National Flood-Frequency Program – 

Methods for Estimating Flood Magnitude and Frequency in Rural Areas in Arizona23 was used. 

 

Contributing Area 

The Contributing Area (CA) of a channel is defined as the area of the hillslopes above the channel 

that can carry water during rain events into the channel.  In a substantial rain event, the precipitation 

that falls across the CA of a channel can drastically increase the discharge within the portion of the 

channel.  Therefore, larger CAs are likely to exhibit larger flows during a substantial rain storm.  

However, it is important to note that many of the ephemeral streams in the arid southwest tend to be 

influenced by high rates of infiltration especially in the flat, sandy areas.  Some of the stream channels 

that have larger CA may actually experience less frequent and lower discharge quantities than channels 

with less CA, especially as the stream moves away from the mountainous and often shallow bedrock 

regions. 

The CA used in this methodology was derived from the FAC grid layers supplied by the NHDPlus 

Version 2 Dataset which counts the number of cells within the HydroDEM that drains into each cell 

based (Figure 15).  Each cell in the FAC grid is 30 by 30 meters and therefore has an area of 900m2 or 

0.0009km2.   The CA values are used in the Flood Peak Discharge, Total Stream Power and Unit Stream 

Power Equations in the following sections.   

123. The Flow Accumulation (FAC) Grid layers that were downloaded through the Horizon Systems 

NHD Plus website24 in the Data Acquisition section were unzipped and uploaded into ARCMap 

10.1 (Refer to Table 1: XXX_FdrFac_01.7z.); at some bases, multiple grids were needed  

                                                           
20 http://pubs.usgs.gov/sir/2008/5119/   (Waltemeyer, 2008) 
21 http://pubs.er.usgs.gov/publication/fs02201  (Sumioka, 2001) 
22 http://pubs.usgs.gov/sir/2012/5113/    (Gotvald, 2012) 
23 http://pubs.er.usgs.gov/publication/fs11198    (Mason, et al. 1999) 
24 http://www.horizon-systems.com/nhdplus/NHDPlusV2_home.php  (Horizon Systems Corporation) 

http://pubs.usgs.gov/sir/2008/5119/
http://pubs.er.usgs.gov/publication/fs02201
http://pubs.usgs.gov/sir/2012/5113/
http://pubs.er.usgs.gov/publication/fs11198
http://www.horizon-systems.com/nhdplus/NHDPlusV2_home.php
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124. The 1m Inundation Layer that was created in Steps 110 – 117 was used to find the max FAC 

value of each reach 

a. The confluences of the 1m reach polygons were removed to eliminate processing errors 

i. Intersect the 1m Inundation Layer on itself (Analysis Tools ->Overlay -> 

Intersect) 

ii. Erase the intersected area (Analysis Tools ->Overlay -> Erase) 

1. Input Features: 1m Inundation Layer 

Erase Features: Intersected layer from Step 124.a.i  

2. This step inevitably erases some polygons to the extent that they do not 

pick up the correct FAC value, but this was mitigated in a later step 

125. The newly created inundation layer was re projected into the same projection as the FAC grid 

layers (Data Management Tools -> Projections and Transformations -> Feature -> Project) 

a. Output Coordinate System: NAD_1983_To_WGS_1984_1 

Geographic Transformation (optional): NAD_1983_To_WGS_1984_1 

Figure 15:  Flow accumulation values from the NHDPlus Version 2 dataset for each Reaches 

at Fort Bliss.  The FAC values are were multiplied 0.0009 to get the contributing area (km2).  
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126. Zonal Statistics as Table was used to find the max FAC value within the reach polygons (Spatial 

Analyst Tools -> Zonal -> Zonal Statistics as Table) 

a. Input raster or feature zone data: 1m Inunadated layer from Step 125  

 Zone field: UniqueID 

 Input value raster: FAC Grid 

 Statistics type (optional): MAX 

b. This was completed for all overlapping grids in the study area 

127. The values were transferred back to the original 1m Inundation Layer by 

a. Adding a new field to the Inundation Layer (Step 15, Figure 5)   

i. Name: fac 

 Type: Long  

b. The tables were joined (Step 16, Figure 6) by the UniqueID field 

c. Field calculator was used to transfer the max field to the fac field (Step 17) 

d. The join was removed (Step 18, Figure 7)   

128. Errors were corrected by using the Symbology Tab (Right click on the feature class, then select 

Properties…), selecting the Graduated Colors under the Quantities tab, then choosing the fac 

field as the Value class; this assisted the detection of incorrect or missing FAC values along the 

flowline network; any errors found were manually inserted into the fac field using the Editor 

Tool 

129. After the FAC values were corrected, the attribute table was exported to a .dbf file and 

uploaded into excel  

130. The fac values of each reach were converted into square miles to be used in the Discharge 

Linear Regression Equations by using the equation: 

 Contributing Area (mi2) = fac value * 0.009km2 * 0.386102mi2/km2 

 

Flood-Peak Discharge 

The Linear Regression equations found in the corresponding state Magnitude and Frequency 

documents that are described in the National Flood Frequency Program introduction were applied to 

calculate the Flood-peak Discharge for the recurrence intervals 2, 5, 10, 25, 50, and 100 years and 

were displayed in cms.  It is important to note that the equations are delivered in US Customary units 

– cfs – and we reported the Flood-Peak Discharge in SI units – cms.  Therefore, the Contributing Area 

for each reach is inputted into the equation in mi2 and the equation then delivers Q in cfs.  If elevation 

was needed, the elevation at the midpoint (in feet) of the reach was used.  After the magnitude of 

discharge was calculated, the volume was then transformed back into cms (by multiplying by 

0.028316). 
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131.  In Excel, the Contributing Area for each reach that was calculated in Step 130 was inserted 

into the Regional Discharge Equations associated with each installation at the 2, 5, 10, 25, 50, 

and 100 year recurrence interval (Table 5) 

132. The Discharge values were converted into cms by multiplying the results by 0.028316m3/ft3 

 

Table 5:  Regional Discharge Equations where A stands for Contributing Area and Qx is 

the Discharge at a specific recurrence interval. 

Recurrence 

Interval 
Fort Bliss 

Fort Huachuca  

& YPG 
Fort Irwin 

Q2  = 146.5 x A0.454 = 10(6.38 – 4.29A-0.06) = 10.3 x A0.506 

Q5 = 277.7 x A0.468 = 10(5.78 – 3.31A-0.08) = 60.0 x A0.506 

Q10 = 387.8 x A0.477 = 10(5.68 – 3.02A-0.09) = 151 x A0.506 

Q25 = 553.7 x A0.488 = 10(5.64 – 2.78A-0.10) = 403 x A0.506 

Q50 = 695.5 x A0.497 = 10(5.57 – 2.59A-0.11) = 760 x A0.506 

Q100 = 851.8 x A0.506 = 10(5.52 – 2.42A-0.12) = 1,350 x A0.506 

 

 
 

Total Stream Power 

The Total Stream Power (TSP) is an estimate of the ability for a stream to transport sediment and 

can be influential within fluvial systems.  The equation for TSP in kW/m is 

Ω = ρgQ“ 

Wheƌe ρ is the density of water at 1.0 kg/m3, g (gravity) = 9.81m/s2, Q = Flood-Peak Discharge for the 

given frequency event (m3/s), S is slope (m/m).  This calculation was completed for the same time 

intervals as the Flood-Peak Discharge by using the corresponding Q variable (2, 5, 10, 25, 50, and 100 

years) that was calculated in the Flood-Peak Discharge section.   

133.  In Excel, the Discharge values (cms) per each recurrence interval were inserted into Equation 

ϯ, ǁheƌe Ω = kW/ŵ 

 Ω = ૚. ૙ �� �ଷ⁄  ×  ૢ. ૡ૚ � �ଶ⁄  × � �ଷ �⁄  × �࢖࢕��  � �⁄  

 

 

 

 

 

 

Equation 3: 
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Unit Stream Power 

The Unit Stream Power (USP) is an estimate of the rate of energy expenditure per unit area of 

channel bed and has relevance in bed sediment entrainment, bedload transport rate and stream 

stability. The equation used for USP in kW/m2 is 

 ω =   ρgS√Q�  

Wheƌe ρ, g, “ aŶd Q aƌe the saŵe ǀaƌiaďles iŶ the Total “tƌeaŵ Poǁeƌ eƋuatioŶ aŶd a is a constant 

between 3.0 and 4.7 depending on the substrate.  In this case, a = 3.6 √�/� was used.  Again, this 

equation was used to calculate the corresponding Q variables in the Flood-Peak Discharge section. 

134.  In Excel, the Discharge values (cms) per each recurrence interval were inserted into Equation 

4, where ω =kW/m2: 

 

� =  ૚. ૙ �� �ଷ⁄  ×  ૢ. ૡ૚ � �ଶ⁄  × �࢖࢕��  � �⁄  ×  √� �ଷ �⁄ �. �√� �⁄⁄  

135.  The Discharge, Total Stream Power and Unit Stream Power were made into a geodatabase 

table with the associated UniqueID, which can be joined to the reach Flowline layer to map 

these quantities across each base 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Equation 4: 
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SUPPLEMENT A: WEATHERED PRODUCTS TEXTURE 

 

 

 

Rock Type reclassified into the Weathered Products Texture parameter.  Note: if a Rock Type is not 

inĐluded in this taďle then it Đan ďe Đlassified as an ͞Unknown͟ 

Rock Type WPT Rock Type WPT 

Alkaline Basalt Fine  Granite Coarse 

Alluvial Fan Unconsolidated 
Granodiorite 

 
Coarse 

Alluvium Unconsolidated Gravel Unconsolidated 

Andesite Fine Intermediate Volcanic Rock Fine 

Argillite Fine 
Lake or Marine Deposit (Non-

Glacial) 
Unconsolidated 

Basalt Fine Lava Flow Fine 

Carbonate 

 
Fine Limestone Fine 

Clastic Coarse Metasedimentary Rock Fine 

Clay or Mud Unconsolidated Mica Schist Fine 

Conglomerate Coarse Mudstone Fine 

Coarse Grained Mixed 

Clastic 
Coarse Plutonic Rock (phaneritic) Coarse 

Dacite Fine Quartz Monzonite Coarse 

Dolostone (dolomite) Fine Quartz-Feldspar Schist Fine 

Dune Sand Unconsolidated Rhyolite Fine 

Eolian Unconsolidated Sand Unconsolidated 
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Felsic Volcanic Rock Coarse Sandstone Coarse 

Fine-Grained Mixed 

Clastic 
Fine Schist Fine 

Gabbro Coarse Sedimentary Rock Fine 

Gneiss Coarse Shale Fine 

 

 

 

 

 

 

 

 

 

 

 

 

 



121 

 

SUPPLEMENT B:  SOIL PROPERTIES AGGREGATED FROM THE NATIONAL SOIL SURVEY HANDBOOK (NSSH):  

PART 618 (SUBPART A) 
 

 Flood Frequency 
Drainage Condition 

Index 
Hydrologic Group K Factor 

Description 

 

The annual probability of a flood 

event 

The natural drainage 

condition of the soil 

refers to the degree, 

frequency and duration 

of wet periods. 

A group of soils having 

similar runoff potential 

under similar storm and 

cover conditions. 

An erodibility factor which 

quantifies the susceptibility 

of soil particles to 

detachment by runoff and 

raindrop impact. 

Data Type Categorical Categorical Categorical Categorical 

Classes 6 7 4 14 

Variables 

1 = None (possibility of flood 

occurring <1 time in 500 yrs) 

2 = Very Rare (possibility of flood 

occurring <1 time in 100yrs) 

3 = Rare (possibility of flood 

occurring 1-5 times in 100yrs) 

4 = Occasional (possibility of flood 

occurring 5-50 times in 100yrs) 

5 = Frequent (possibility of flood 

occurring is >50 times in 100yrs, 

but less than 50% chance of flood 

occurring in all mon/yr) 

6 = Very Frequent (possibility of 

flood occurring is >50 times in 

100yrs, but more than 50% chance 

of flood occurring in all mon/yr) 

1 = Excessive 

2 = Somewhat 

Excessive 

3 = Well Drained 

4 = Moderately 

Drained 

5 = Somewhat Poorly 

Drained 

6 = Poorly Drained 

7 = Very Poorly 

Drained 

A 

= low runoff potential 

 

B 

= moderately low runoff 

potential 

 

C 

= moderate runoff 

potential 

 

D, A/D, B/D, C/D 

= high runoff potential 

0.02 

0.05 

0.10 

0.15 

0.17 

0.20 

0.24 

0.28 

0.32 

0.37 

0.43 

0.49 

0.55 

0.64 

Table Name muaggatt muaggatt muaggatt chorizon 

Field Name flodfreqdcd drclassdcd hydgrpdcd kffact 

NHHS Source 

(USDA n.d.) 
618.30 Flodding Frequency Class 618.18 Drainage Class 618.39 Hydrologic Group 

618.58 Soil Erodibility 

Factors 



122 

 

SUPPLEMENT C: MAP EXAMPLES OF DERIVED DATA 
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